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About this document

The products IBM® WebSphere® Business Integration Server Express and IBM®

WebSphere® Business Integration Server Express Plus are made up of the following
components: InterChange Server Express, the associated Toolset Express,
CollaborationFoundation, and a set of software integration adapters. The tools in
the Toolset Express help you to create, modify, and manage business processes.

you can choose from among the prepackaged adapters for your business processes
that span applications. the standard processes template--CollaborationFoundation--
allows you to quickly create customized processes.

Except where noted, all the information in this guide applies to both IBM
WebSphere Business Integration Server Express and IBM WebSphere Business
Integration Server Express Plus. The term "WebSphere Business Integration Server
Express” and its variants refer to both products.

Audience

This document is for consultants, developers, and system administrators who
support and manage the WebSphere Business Integration Server Express system at
customer sites.

Prerequisites for this document

Users of this document should be familiar with the WebSphere Business
Integration Server Express system, with business object and collaboration
development, and with the COM technology.

Related documents

The complete set of documentation available with this product describes the
features and components common to all WebSphere Business Integration Server
Express installations and includes reference material on specific components.

You can download, install, and view the documentation at the following site:
http:/ /www.ibm.com /websphere /wbiserverexpress/infocenter

Typographic conventions

This document uses the following conventions:

courier font Indicates a literal value, such as a command name, filename,
information that you type, or information that the system
prints on the screen.

bold Indicates a new term the first time that it appears.
italic, italic Indicates a variable name or a cross-reference.
blue outline A blue outline, which is visible only when you view the

manual online, indicates a cross-reference hyperlink. Click
inside the outline to jump to the object of the reference.

{1 In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

© Copyright IBM Corp. 2004, 2005 \%



vi

[]

ProductDir

In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.

In a naming convention, angle brackets surround individual
elements of a name to distinguish them from each other, as
in <server_name><connector_name>tmp.10g.

In this document, backslashes (\) are used as the convention
for directory paths. All product pathnames are relative to the
directory where the product is installed on your system.
Text within percent (%) signs indicates the value of the
Windows™ text system variable or user variable.
Represents the directory where the product is installed.
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New in this release

New in Release 1.2.x

Updated in June 2004. For version 1.2.x of the adapter for COM, the manual has
been updated with editorial clarifications.
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Chapter 1. Overview

« |”Adapter environment”]

* |“Terminology” on page 2|

» |“Architecture of the COM connector” on page 3

+ [“Business object requests” on page 7|

* |“Verb processing” on page 7

» [“Custom business object handlers” on page 8|

* |"DCOM support” on page 11

» [“Processing locale-dependent data” on page 11|

The connector for COM is a run time component of the adapter for COM. The
COM Adapter includes a connector, message files, configuration tools, and an
Object Discovery Agent (ODA). The connector allows the Interchange Server
Express integration broker to exchange business objects with applications, or
Common Object Model (COM) components, running on a COM server.

Connectors consist of two components: the connector framework and the
application-specific component. The connector framework, whose code is common
to all connectors, acts as an intermediary between the integration broker and the
application-specific component. The application-specific component contains code
tailored to a particular technology (in this case, COM) or application. The
connector framework provides the following services between the integration
broker and the application-specific component:

* Receives and sends business objects
* Manages the exchange of startup and administrative messages

This document contains information about both the connector framework and the
application-specific component. It refers to both of these components as the
connector.

Note: The term connector component refers to a part of a connector, and should not
be confused with the term COM component, which refers to the binary
software components used in the COM software architecture.

Adapter environment
Before installing, configuring, and using the adapter, you must understand its
environment requirements.

+ |“Adapter standards”|

+ [“Adapter platforms” on page 2|

« |“Adapter dependencies” on page 2|

Adapter standards

The connector is written to the COM 2.0 specification and as such is compatible
with COM applications designed to this standard.

For information about COM, see |http:/ /www.microsoft.com/com /tech/com.asp|

© Copyright IBM Corp. 2004, 2005


http://www.microsoft.com/com/tech/com.asp

Adapter platforms

The connector runs on the Windows 2003 platform.

Adapter dependencies

The connector has the following dependencies.

JDK software

The Java Development Kit (JDK), Version 1.3.x, is a prerequisite of installing the
adapter for COM. If you do not already have this version of the JDK installed, the
WebSphere Business Integration Adapter Framework, Version 2.4 software package
(Windows version only) provides a separate installation for the IBM JDK, Version
1.3.1. Note that the IBM JDK, Version 1.3.1 is not installed as part of the
WebSphere Business Integration Adapter Framework installation. You must run a
separate installation to install the JDK. For details about how to install the JDK
from WebSphere Business Integration Adapter Framework, refer to that software
package.

COMProxy

The connector uses COMProxy, an interface tool that allows Java programs to
communicate with ActiveX objects. This tool generates the Java proxy objects that
the connector requires to invoke COM components. The properties, structures, and
methods of a COM component are typically defined in a type library file (.t1b,
.d11, .ole, .0lb, or .exe). Using the Java Native Interface and COM technology,
COMProxy allows a COM component to be treated just like a Java object.

* The connector’s startup script ensures that the following COMProxy classes in
the package com.ibm.adapters.utils.comproxy are included in the classpath at
run time:

— ActiveXCanvas.class
— COMconstants.class
— ComException.class
— Dispatch.class

— JVariant.class

— OleEnvironment.class

e The COMProxy C++ run time library (BIA_COMProxy.d11) is included in the
adapter for interfacing with the COM server. The connector’s startup script
ensures that this DLL is in the connector’s java.library.path.

¢ The connector supports COM objects that implement the Dispatch (OLE
Automation) interface type.

Terminology

The following terms are used in this guide:

* ASI (Application-Specific Information) Metadata tailored to a particular
application or technology. ASI exists at both the attribute and business object
level of a business object. See also Verb ASI.

* BO (Business Object) A set of attributes that represent a business entity (such as
Employee) and an action on the data (such as a create or update operation).
Components of the WebSphere Business Integration Server Express system use
business objects to exchange information and trigger actions.

* BO (Business Object) handler A connector component that contains methods
that interact with an application and that transforms request business objects
into application operations.

2 Adapter for COM User Guide



¢ COM component The connector interacts with a COM server by processing
between a business object and a COM component object. During connector
processing, a COM component, which is part of a COM application, is
represented in the connector by a proxy object. A proxy is a Java class that
represents a COM component.

¢ COMProxy The interface tool that allows Java programs to communicate with
ActiveX objects. This tool generates the Java proxy objects that the connector
requires to invoke COM components. The properties, structures, and methods of
a COM component are typically defined in a type library file (.t1b, .d11, .oTe,
.0lb, or .exe). Using the Java Native Interface and COM technology, COMProxy
allows a COM component to be treated just like a Java object.

* Connection factory A special kind of proxy object that refers to an application. If
the appropriate connector properties are set, the factory object, which is
persistent for the life of the connector, can create connections that are placed in
the connection pool. The number of connections created depends on the value
specified in the PoolSize property.

* Connection object A special kind of proxy object that is an instance of the
connection class. A connection is a reference to an application that can contain
state information. For every instance of a connection on the adapter side, there is
a corresponding object on the COM side. Connections can be instantiated in
batches, retrieved at will, sent back to the connection pool, and be re-used by
another thread.

* Connection pool A repository used to store and retrieve connection objects.

* Foreign key A simple attribute whose value uniquely identifies a child business
object. Typically, this attribute identifies a child business object to its parent by
containing the child’s primary key value. The connector for COM uses the
foreign key to specify poolable connection objects.

* ODA (Object Discovery Agent) A tool that automatically generates a business
object definition by examining specified entities within the application and
“discovering” the elements of these entities that correspond to business object
attributes. When you install the adapter, the ODA is automatically installed.
Business Object Designer Express provides a graphical user interface to access
the ODA and to work with it interactively.

* Per-call object pool A programmatic entity for storing objects that need to pass
from one method to the next during a single doVerbFor method call. Stored
objects may be proxy objects or simple attributes.

* Proxy class A Java class that represents a COM component class in the
connector. The connector creates a proxy object instance of the proxy class name
specified in the business object’s ASL.

* Verb ASI (application-specific information) For a given verb, the verb ASI
specifies how the connector should process the business object when that verb is
active. It can contain the name of the method to call to process the current
request business object.

Architecture of the COM connector

To illustrate the architecture of the connector, this section describes request
processing at a high-level, as illustrated in |Figure 1 on page 4] and then the details
of how the connector works, as illustrated in [Figure 2 on page 5

Chapter 1. Overview 3
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Figure 1. Request processing in the connector for COM

1. The connector receives a business object request from the integration broker.

2. The connector creates a proxy object instance of the business object. The proxy
object instance acts as a representation of the COM object to which the
connector is sending the request. For details about how the connector creates
and processes the proxy object, see [‘How the connector works.”|

3. The connector processes the proxy object by using it to invoke the
corresponding COM object running on COM server and write data to the COM
application.

4. The connector updates the proxy object by reading, or getting, data from COM
server object.

5. The adapter returns a message to the integration broker indicating that the
original object request was either successful or unsuccessful (a FAIL status). If
the request was successful, the connector also returns the updated business
object to the broker.

How the connector works

This section describes how the different parts of the connector process a business
object, as illustrated in |Figure 2 on page 5l
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Figure 2. The connector for COM

1. When you first start up the connector, the connector’s Agent class performs

the following initialization processes:

* Instantiates the OLE environment.

* Does one of the following, depending on how the connector properties have
been set. For details about the connector properties and how they affect
each of the following scenarios, see [“Connector-specific properties” on page|

— Scenario 1: Creates a connection factory object instance, which is an
object that refers to an application. The factory object is persistent for the
life of the connector and creates connections that are placed in the
connection pool. The number of connections created depends on the
value specified in the connector Pool1Size property.

Chapter 1. Overview
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— Scenario 2: Creates connection objects only that are placed in the
connection pool. The number of connections depends on the value
specified in the Poo1Size property. No factory object is created in this
scenario.

— Scenario 3: Creates a factory proxy object against which the business
object will call methods (the factory class matches the proxy class ASI of
the BO). In this scenario, no connections are created.

2. The integration broker sends a request, in the form of a business object, to the
connector.

3. The connector’s BO handler receives the object.

4. The doVerbFor() method of the BO handler calls the Dispatch() method,
which reads the BO ASI to obtain the proxy class name. The Dispatch()
method gets the proxy class name and sends it to the Loader.

5. The Loader uses the proxy class name to load the proxy class (qualified using
valid Java class notation, ie. Mypackage.myclass) and create a proxy object
instance, loading it in the per-call object pool. The Loader checks to see if the
object is one of the following;:

* Is it a connection? If so, retrieve it as a connection object from the
connection pool.

* Is it a factory object? If so, retrieve it as a static object from the connection
factory.

6. Dispatch then reads through the BO’s verb ASI and builds a list of methods.
The verb ASI is an ordered list of attribute names. Each attribute represents a
method on the proxy object. In other words, the verb ASI is not a list of
methods, but a list of attributes, each one having a value that represents a
proxy object method.

7. For each method on the verb ASI list, the InvokeMethods () method of the BO
handler calls InvokeMethod() to do one of the following;:

 Call Invoker, if the method is a regular method. If the argument is marked
as a foreign key, store it in the per-call object pool. If the attribute is not
populated, check the attribute ASI for use_attribute_value. If the
use_attribute_value ASI is present, attempt to pull the object from the
per-call object pool.

* Call the Load (LoadFromProxy function) and Store (WriteToProxy function)
operations of Synchronizer (the BO handler’s object synchronization
process) against all attributes on the proxy object. The operation called
depends on what is in the verb ASI. LoadFromProxy (Load) and
WriteToProxy (Store) are pre-defined functions that you can include in the
verb ASI. Their purpose is to synchronize a business object’s simple
attributes to a COM component’s public properties.

* Call Load or Store operations against a single, specific attribute
(LoadFromProxy gets the proxy property and sets the BO property to that
value; WriteToProxy sets the proxy property with values from the BO).

Note: If the verb ASI is empty, the BO handler will search for a method on
the BO with populated parameters and call that. Only one method can
have populated parameters. Otherwise, if multiple methods are
populated and the verb ASI is empty, then the connector logs an error
and returns a FAIL code.

8. For each method of the proxy object, Invoker constructs the parameters and
arguments of the method by doing the following:
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* If it encounters a BO type (rather than a simple data type, such as a String)
in the attribute, Invoker recursively calls the Dispatch() method on the
active BO handler.

* Dispatch() returns a proxy object that the parent method can use to invoke
its method call.

* The BO handler’s synchronization process, called Synchronizer, invokes
WriteToProxy to store (set) a value in each property of the COM component
(proxy object), thus updating data on the COM server. The value stored is
from the corresponding attribute on the business object that the COM
component corresponds to.

9. When values are returned from the COM server, the LoadFromProxy function
calls the “getters” of the proxy object and loads the data returned from the
proxy object onto the BO.

10. The connector returns the business object to the integration broker.

Business object requests

Business object requests are processed when the integration broker sends a
business object to the connector. The only requirement of the business object is that
it must map to the corresponding COM component object that the proxy object
will represent. The proxy class is a Java class that represents a COM component in
the connector. The connector creates a proxy object instance of the proxy class
name specified in the business object’s ASL

Verb processing

The connector processes business objects passed to it by a broker based on the verb
for each business object.

When the connector framework receives a request from the broker, it calls the
doVerbFor() method of the business-object-handler class associated with the
business object definition of the request business object. The role of the
doVerbFor() method is to determine the verb processing to perform, based on the
active verb of the request business object. It obtains information from the request
business object to build and send requests for operations to the application.

When the connector framework passes the request business object to doVerbFor(),
this method retrieves the business object ASI and invokes the BO handler, which in
turn reads the verb ASI and translates it into a series of callable functions. The
verb ASI is an ordered list of the methods that need to be called for that verb. The
order in which the calls are made is critical to the successful processing of the
object.

The connector supports processing multiple components in a single
doVerbFor()call.

For examples of the sequence of calls that the connector makes during verb
processing, see [‘Sample business object properties” on page 31| and [Figure 16 on|
|- ge 44

If the verb ASI is blank, the BO handler searches for a method with populated
parameters and calls that. Only one method can be populated; otherwise, if
multiple methods are populated yet the verb ASI is blank, the connector logs an
error and returns a FAIL code. For details about error processing, see
lhandling” on page 49
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The connector does not support any specific verbs, but using the ODA, the user
can configure custom verbs.The standard, pre-existing verbs are Create, Retrieve,
Update, and Delete. These can be given whatever semantic meaning you provide
through the Object Discovery Agent (ODA) running in Business Object Designer
Express. For details about using the ODA to assign a method call sequence to a
verb, see|Chapter 5, “Creating and modifying business objects,” on page 37/

Note: You can specify two pre-defined functions in the verb ASI: LoadFromProxy
and WriteToProxy. Their purpose is to synchronize a business object’s simple
attributes to a COM component’s public properties.

Custom business object handlers

When you create a business object, you can override the default BO handler by
specifying the CBOH keyword in the BO verb ASI. At connector run time, the
doVerbFor() method retrieves the business object ASL. If it detects the CBOH
keyword, doVerbFor() invokes the custom BO handler.

A custom BO handler can access proxy classes directly. Therefore, it bypasses the
Loader, the Invoker, and the process of retrieving connections from the connection
pool. These processes are described in Step and Step
The connector supports custom BO handlers on parent-level business objects only.

Custom BO handler example

The following example of a custom BO handler assumes that a business object has
been defined with a verb ASI of CBOH=comadaptertest.Lotus123BOHandler. The
business object has an attribute ASI of Cel1Address=Al, where Al is the address in
which the attribute will appear in the worksheet. The custom BO handler puts the
attribute on the worksheet, using the cell address specified by the attribute ASL

package comadaptertest;

import com.crossworlds.cwconnectorapi.*;

import com.crossworlds.cwconnectorapi.exceptions.*;
import java.util.x;

import com.ibm.adapters.utils.comproxy.*;

import lotusl23.=;

public class Lotusl23BOHandler implements
CWCustomBOHandlerInterface {

public int doVerbForCustom(CWConnectorBusObj bo) throws
VerbProcessingFailedException {

Application currentApplication;
Document currentDocument;

CWConnectorUtil.traceWrite(CWConnectorUtil.LEVEL4,
"Entering AdapterBOHandler.doVerbFor()");

try {
currentDocument = new Document();

// Get the application object.
currentApplication = new Application(currentDocument.
get_Parent());

// Make the application visible.

currentApplication.set Visible(new Boolean("true"));
currentDocument = new Document (currentApplication.
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NewDocument () ) ;

} catch (ComException e) {

CWConnectorUtil.generateAndLogMsg (91000,
CWConnectorUtil.XRD_ERROR, CWConnectorUtil.
CONNECTOR_MESSAGE_FILE,
e.getMessage());

CWConnectorExceptionObject vSub = new
CWConnectorExceptionObject();

vSub.setMsg(e.getMessage());

vSub.setStatus (CWConnectorConstant.
APPRESPONSETIMEOUT) ;

throw new VerbProcessingFailedException(vSub);

}

//do verb processing on this business object
dispatch(bo, currentDocument);

CWConnectorUtil.traceWrite(CWConnectorUtil.
LEVEL4, "Leaving AdapterBOHandler.doVerbFor()");

return CWConnectorConstant.SUCCEED;
} //doVerbFor

private void dispatch(CWConnectorBusObj bo,
Document currentDocument) throws VerbProcessingFailedException {

CWConnectorUtil.traceWrite(CWConnectorUtil.
LEVEL4, "Entering dispatch");

CWConnectorUtil.traceWrite(CWConnectorUtil.
LEVEL3, "Processing business object" + bo.getName());

try {
//put this object out onto the spreadsheet.
//Follow ASI for Cell addresses
businessObjectToWorksheet (bo, currentDocument);
} catch (ComException e) {
CWConnectorUtil.generateAndLogMsg (90001,
CWConnectorUtil.XRD_ERROR, CWConnectorUtil.
CONNECTOR_MESSAGE_FILE, e.getMessage());
CWConnectorExceptionObject vSub = new
CWConnectorExceptionObject();
vSub.setMsg(e.getMessage());
vSub.setStatus (CWConnectorConstant.
APPRESPONSETIMEOUT) ;
throw new VerbProcessingFailedException(vSub);

} catch (CWException e) {
CWConnectorExceptionObject vSub = new
CWConnectorExceptionObject();
vSub.setMsg(e.getMessage());
vSub.setStatus (CWConnectorConstant.FAIL);
throw new VerbProcessingFailedException(vSub);

}

public static void businessObjectToWorksheet (CWConnectorBusObj
bo, Document currentDocument) throws CWException {
String incomingAttribute = "";
int attrCount = bo.getAttrCount() - 1; //ignore objeventID
Ranges ranges;
Range currentRange;

ranges = new Ranges(currentDocument.get Ranges());

Chapter 1. Overview



for (int i = 0; i < attrCount; i++) {
try {
if ((!'bo.isObjectType(i)) && (!bo.isIgnore(i)))
if (bo.isBlank(i))
incomingAttribute = "";
else

incomingAttribute
bo.getStringValue(i);

String CellAddress = getCellAddress(bo, i);

currentRange = new Range(ranges.Item(new
String(Cel1Address)));

currentRange.set_Contents(incomingAttribute);

if (CWConnectorUtil.isTraceEnabled
(CWConnectorUtil.LEVEL5)) {
CWConnectorUtil.tracelWrite
(CWConnectorUtil.LEVEL5,
"Application datum from BO to application " + CellAddress + "=" +
incomingAttribute);
}
1

} catch (AttributeNotFoundException e) {
CWConnectorUtil.generateAndLogMsg (91012,
CWConnectorUtil.XRD_ERROR,
CWConnectorUtil.CONNECTOR_MESSAGE_FILE,
bo.getAttrName(i), bo.getName());
throw e;
} catch (WrongAttributeException e) {
CWConnectorUtil.generateAndLogMsg (91013,
CWConnectorUtil.XRD_ERROR,
CWConnectorUti1.CONNECTOR_MESSAGE_FILE,
bo.getAttrName(i), bo.getName());
throw e;
}

}
1
public static String getCellAddress(CWConnectorBusObj bo, int 1)
throws CWException {
String columnName = null;
try {
columnName = getNameFromASI
(bo.getAttrASIHashtable(i, ":"), "CellAddress");
} catch (WrongASIFormatException e) {
CWConnectorUtil.generateAndLogMsg (91014,
CWConnectorUtil.XRD_ERROR,
CWConnectorUti1.CONNECTOR MESSAGE_FILE, bo.getAttrName(i),
"ColumnName") ;
throw e;

}

return columnName;

}
private static String getNameFromASI(Hashtable asi, String fieldName)

throws CWException,
WrongASIFormatException {
String resultName = (String) asi.get(fieldName);

if (resultName == null || resultName.equals(""))
throw new WrongASIFormatException();

resultName = resultName.toUpperCase();

CWConnectorUtil.traceWrite(CWConnectorUtil.LEVEL4, "Found " +
fieldName + " = " + resultName);
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return resultName;

DCOM support

The Distributed Component Object Model (DCOM) is a protocol that enables
software components to communicate directly over a network. It extends COM to
support communication among objects on different computers—on a LAN, a WAN,
or even the Internet. With DCOM, an application can be distributed across various
locations.

The connector provides DCOM support by allowing you to specify the remote
server name when you create an object at another location. The remote server
name can be specified as a fixed configuration in the system registry of the
machine where the connector is running or in the DCOM Class Store. By
registering the remote server, the connector has transparent access to the DCOM
components.

Processing locale-dependent data

The connector has been internationalized so that it can support delivery of
double-byte character sets going into a COM interface that also supports
double-byte character sets, and deliver message text in the specified language.
When the connector transfers data from a location that uses one character code to a
location that uses a different code set, it performs character conversion to preserve
the meaning of the data.

The Java run time environment within the Java Virtual Machine (JVM) represents
data in the Unicode character code set. Unicode contains encodings for characters
in most known character code sets (both single-byte and multibyte). Most
components in the WebSphere Business Integration Server Express system are
written in Java. Therefore, when data is transferred between most integration
components, there is no need for character conversion.

Chapter 1. Overview 11
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Chapter 2. Installlng the adapter

“Overview of installation tasks”|
+ [“Install the adapter for COM and related files”|

+ |“Connector file structure”|

This chapter describes how to install the connector.

Overview of installation tasks

To install the connector for COM, you must perform the following tasks:

Confirm adapter prerequisites

Before you install the adapter, confirm that all the environment prerequisites for
installing and running the adapter are on your system. For details, see
fenvironment” on page 1)

Install the integration broker

Installing the integration broker, a task that includes installing InterChange Server
Express and starting the integration broker, is described in the documentation.

Install the adapter for COM and related files

For information on installing WebSphere Business Integration Server Express
adapter products, refer to the WebSphere Business Integration Server Express
Installation Guide for Windows. The guide is located in the WebSphere Business
Integration Server Express Adapters Infocenter at the following site:

http:/ /www.ibm.com /websphere /wbiserverexpress/infocenter.

Connector file structure

The Installer copies the standard files associated with the connector into your
system.

The utility installs the connector into the ProductDir\connectors\COM directory, and
adds a shortcut for the connector to the Start menu. Note that ProductDir
represents the directory where the connector is installed.

describes the file structure used by the connector, and shows the files that
are automatically installed when you choose to install the connector through the
Installer.

Table 1. File structure for the connector

Subdirectory of ProductDir Description

\connectors\COM\BIA_COM. jar Contains classes used by the COM connector only
\connectors\COM\start_COM.bat The startup script for the generic connector

\connectors\COM \start_COM_service.bat The startup script for the connector service.

\connectors\COM\ext\ A directory where the ODA-generated . jar files can be saved. If you save to

this directory, specify the directory in the startup script (start_COM.bat).
\connectors\COM\BIA_COMProxy.d11 The COMProxy C++ run time library that defines the properties, structures,

and methods of the Java proxies used to invoke COM components. Enables the

connector to interface with a COM Server.
\connectors\messages\BIA_COMConnector. txt Message file for the connector

\ODA\COM\BIA_COMODA. jar The COM ODA
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Table 1. File structure for the connector (continued)

Subdirectory of ProductDir Description
\ODA\COM\start_COMODA.bat The ODA startup file
\ODA\COM\BIA_COMProxyGen.exe Generates the proxy classes that will be used by the connector to create proxy
object instances of those classes
\ODA\messages\BIA_COMODAAgent_de_ DE.txt Message file for the ODA (German text strings)
\ODA\messages\BIA_COMODAAgent_en_US.txt Message file for the ODA (US English text strings)
\ODA\messages\BIA_COMODAAgent_es_ES.txt Message file for the ODA (Spanish text strings)
\ODA\messages\BIA_COMODAAgent_fr_FR.txt Message file for the ODA (French text strings)
\ODA\messages\BIA_COMODAAgent_it_IT.txt Message file for the ODA (Italian text strings)
\ODA\messages\BIA_COMODAAgent_ja_ JP.txt Message file for the ODA (Japanese text strings)
\ODA\messages\BIA_COMODAAgent_ko_KR.txt Message file for the ODA (Korean text strings)
\ODA\messages\BIA_COMODAAgent_pt_BR.txt Message file for the ODA (Portuguese - Brazil -text strings)
\ODA\messages\BIA_COMODAAgent_zh_CN.txt Message file for the ODA (Simplified Chinese text strings)
\ODA\messages\BIA_COMODAAgent_zh_TW.txt Message file for the ODA (Traditional Chinese text strings)
\repository\COM\BIA_CN_COM.txt Repository definition for the connector. The default name is BIA_CN_COM.txt.

Note: All product pathnames are relative to the directory where the product is
installed on your system.

Post-installation tasks

After you install the adapter, you must configure it before you can run it. For
details, see [Chapter 3, “Configuring the adapter,” on page 15/
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Chapter 3. Conflgurlng the adapter

“Overview of configuration tasks”|

* |“Configuring the connector”

» |“Creating multiple connector instances” on page 19

» [“Configuring the startup file” on page 20|

* |“Starting the connector” on page 21

» [“Stopping the connector” on page 21|

* [“Using log and trace files” on page 21|

Overview of configuration tasks

After installation and before startup, you must configure components as described
in this section.

Configure the connector

Configuring the connector includes setting up and configuring the connector. For
details, see [‘Configuring the connector.”|

Configure the business objects

You configure business objects through an ODA (Object Discovery Agent). The
ODA enables you to generate business object definitions. A business object
definition is a template for a business object. The ODA examines specified
application objects, “discovers” the elements of those objects that correspond to
business object attributes, and generates business object definitions to represent the
information. Business Object Designer Express provides a graphical interface to
access the Object Discovery Agent and to work with it interactively.

For details about using the ODA, see [Chapter 5, “Creating and modifying busines|
fobjects,” on page 37

Configuring the connector

Connectors have two types of configuration properties: standard configuration
properties and adapter-specific configuration properties. You must set the values of
these properties using Connector Configurator Express before running the adapter.
For further information, see[Appendix B, “Connector Configurator Express,” on|

A connector obtains its configuration values at startup. During a run time session,
you may want to change the values of one or more connector properties. Changes
to some connector configuration properties, such as AgentTraceLevel, take effect
immediately. Changes to other connector properties require connector component
restart or system restart after a change. To determine whether a property is
dynamic (taking effect immediately) or static (requiring either connector
component restart or system restart), refer to the Update Method column in the
Connector Properties window of the System Manager.
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Standard connector properties

Standard connector configuration properties provide information that all adapters
use. See|[Appendix A, “Standard configuration properties for connectors,” on page|
for documentation of these properties.

The following table provides information specific to this connector about standard
configuration properties listed in the appendix.

Property Description

DuplicateEvent Elimination | The connector does not use this property.

Locale Because this connector has been internationalized, you can
change the value of this property.

PollEndTime The connector does not use this property.

PollFrequency The connector does not use this property.

PollStartTime The connector does not use this property.

You must provide a value for the ApplicationName configuration property before
running the connector.

Connector-specific properties

Connector-specific configuration properties provide information needed by the
connector at run time. These properties also provide a way for you to change static
information or logic within the connector without having to recode and rebuild it.

To configure connector-specific properties, use Connector Configurator Express.
Click the Application Config Properties tab to add or modify configuration
properties. For more information, see |Appendix B, “Connector Configurator]
[Express,” on page 73]

Note that all the connector-specific properties are optional in that you can choose
to set them based on your specific connector configuration requirements: Do you
want the connector to create both factory objects and connections, only a factory

object, or only connections?

lists the connector-specific configuration properties for the connector, along
with their descriptions and possible values. The + character indicates the entry’s
position in the property hierarchy. See the sections that follow for details about the
properties, including a representation of the hierarchical relationship of the
properties in |[Figure 3 on page 17]

Table 2. Connector-specific configuration properties

Default
Name Possible values value
+ None None
++ The class name None
+ + Method name of the initializer None
+++ Any encrypted or non-encrypted strings None
+ + [FactoryMethod| Method name None
+ + + Any encrypted or non-encrypted strings None
+ None None
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Table 2. Connector-specific configuration properties (continued)

Default
Name Possible values value
++ Class name None
+ +|Connectionlnitializer| Method name of the initializer None

+ + + Any encrypted or non-encrypted strings None
+ + Any integer 0
+ [ThreadingModel Apartment, Free Free

illustrates the hierarchical relationship of the connector-specific properties.

[ Connector properties ]

_[ Factory ]

FactoryClass ]

—[ Factorylnitializer J

n Arguments (Argument1 to ArgumentN) ]

—[ FactoryMethod ]

n Arguments (Argument1 to ArgumentN) ]

—[ Connectionlnitializer ]

I—[ n Arguments (Argument1 to ArgumentN) ]

—( PoolSize ]
_[ ThreadingModel ]

Figure 3. Hierarchy of connector-specific properties

Factory
A hierarchical property that represents the Factory class information.

FactoryClass
The name of the factory class.
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 If you specify a FactoryClass, a ConnectionClass, and a FactoryMethod, the
connector instantiates a factory proxy object and connections (Scenario 1 in step
[1 on page 5| of [How the connector works).

* If you do not specify a FactoryClass, then specify a ConnectionClass, in which
case a connection pool of the specified connection class and size is created when
you initialize the connector (Scenario 2 in step .

* If you specify a FactoryClass only, the connector will instantiate a factory proxy
object (Scenario 3 in step [l on page 5) and will not use connections.
Factorylnitializer

The method name of the initializer for the FactoryClass. This method never acts as
a constructor.

Arguments
String values representing the parameters of the FactoryInitializer method. These
can be any encrypted or non-encrypted strings.

FactoryMethod

The method name of the FactoryMethod on the FactoryClass. If you specify a
FactoryMethod, the connection pool obtains connections using the FactoryMethod.
ConnectionInitializer is called after a connection object is created. The connection
may or may not come from the FactoryMethod.

Arguments

The parameters of the FactoryMethod must be arguments (Argumentl, Argument2,
and so on) on the Factory, listed in proper sequential order. The property names
are Argumentl, Argument2, and so on, for as many parameters as the method takes.
The value of each argument is any encrypted or non-encrypted string.

ConnectionPool
The property for the Connection class information.

ConnectionClass

The name of the poolable connection class.

* If you specify a ConnectionClass and a FactoryClass, the connector instantiates a
factory proxy object and a connection pool instance is created for storing
connections. The connections are created by the Factory. (Scenario 1 in step
page 5).

* If you specify a ConnectionClass, but not a FactoryClass, then, when the
connector is initialized, a connection pool instance is created for storing
connections (Scenario 2 in step . In this scenario, the connections are
not created by the Factory.

The size of the pool (number of connections) is based on the value you specify in
the PoolSize property.

Since a connection is a reference to an application with some kind of state
information, note that if you use connection pooling on a single-use server,
multiple instances of the application referenced by the connection are created. Each
instance is called on a single BO handler thread.

Likewise, if you use connection pooling on a multi-use server (one instance of a
server object can be re-used to create a connection), then you have to set up a
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factory and factory method call to create the connection pool. In this case, each BO
handler thread pulls a discrete connection from the pool to be used during
processing.

Connectionlnitializer
The name of the poolable ConnectionClass initializer method. This method never
acts as a constructor.

ConnectionInitializer is called after the connection object is created, whether or
not the connection comes from the Factory.

Arguments
String values representing parameters for the initializer. The values may be
encrypted or non-encrypted strings.

PoolSize
Determines the size of the connection pool. This property is required if you specify
a |ConnectionClass}

ThreadingModel

Indicates whether the connector uses the Multi-Threaded Apartment (MTA) or the
Single Threaded Apartment (STA) threading model. If this property is set to
Apartment, the connector runs in STA mode (not threadsafe). STA mode causes the
connector to be single-threaded.

If the property is set to Free, the connector runs in MTA mode. In MTA mode
(threadsafe), multi-threaded clients can make direct calls to the object. The default
value is Free (threadsafe, Multi-Threaded Apartment mode).

Note: If you are running in Single-Threaded Apartment mode (you have set the
property value to Apartment), the connection pool and factory are disabled.

Creating multiple connector instances

Creating multiple instances of a connector is in many ways the same as creating a
custom connector. You can set your system up to create and run multiple instances
of a connector by following the steps below. You must:

* Create a new directory for the connector instance
* Make sure you have the requisite business object definitions
* Create a new connector definition file

* Create a new start-up script

Create a new directory

Create a new directory: ProductDir\connectors\connectorInstance.

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file, create
this directory and store the file here:

ProductDir\repository \connectorInstance

where connectorlnstance uniquely identifies the connector instance.

You can specify the InterChange Server Express server name as a parameter of
startup.bat; an example is: start_COM.bat connName serverName.
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Create business object definitions

If the business object definitions for each connector instance do not already exist
within the project, you must create them.

1. If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer
Express to import them. You can copy any of the files for the initial connector.
Just rename them if you make changes to them.

2. Files for the initial connector should reside in the following directory:
ProductDir\repository\initialConnectorinstance

Any additional files you create should be in the appropriate connectorInstance
subdirectory of ProductDir\repository.

Create a connector definition

You create a configuration file (connector definition) for the connector instance in
Connector Configurator Express. To do so:

1. Copy the initial connector’s configuration file (connector definition) and rename
it.

2. Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

3. Customize any connector properties as appropriate.

Create a start-up script
To create a startup script:

1. Copy the initial connector’s startup script and name it to include the name of
the connector directory:

dirname

2. Put this startup script in the connector directory you created in
[business object definitions.”]

3. Create a startup script shortcut.

4. Copy the initial connector’s shortcut text and change the name of the initial
connector (in the command line) to match the name of the new connector
instance.

Configuring the startup file

Before you start the connector for COM, you must configure the startup file.

To complete the configuration of the connector for Windows platforms, you must
modify the start_COM.bat file:

1. Open the start_COM.bat file.
2. Scroll to the section beginning with “SET JCLASSES..."

3. Edit the JCLASSES variable to point to the jar file created by the ODA. For
example, if the jar file created by the ODA is
c:\WebSphereAdapters\connectors\COM\SampleLotus123.jar, then set the
JCLASSES variable to JCLASSES=
c:\WebSphereAdapters\connectors\COM\SampleLotus123.jar;%JCLASSES%
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Starting the connector

A connector must be explicitly started using its connector start-up script. On
Windows systems the startup script should reside in the connector’s runtime
directory:ProductDir\connectors\connNamewhere connName identifies the connector.

Table 3. Startup scripts for a connector

Operating system Startup script

Windows start_connName .bat

When the startup script runs, it expects by default to find the configuration file in
the Productdir (see the commands below). This is where you place your
configuration file.

Note: You need a local configuration file if the adapter is using JMS transport.
 Starting the connector:

— From the Start menu, select Programs>IBM WebSphere Business Integration
Server Express>Adapters>Connectors. By default, the program name is “IBM
WebSphere Business Integration Server Express”. However, it can be
customized. Alternatively, you can create a desktop shortcut to your
connector.

— From the Windows command line: start_connName connName brokerName
{-cconfigFile}.

— On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector starts when the Windows system boots (for
an Auto service) or when you start the service through the Windows Services
window (for a Manual service).

Stopping the connector

The way to stop a connector depends on the way that the connector was started.

* You can invoke the startup script which creates a separate “console” window for

“u_

the connector. In this window, type “q” and press Enter to stop the connector.

* You can configure the connector to start as a Windows service. In this case, the
connector stops when the Windows system shuts down.

Using log and trace files

The adapter components provide several levels of message logging and tracing.
The connector uses the adapter framework to log error, informational, and trace
messages. Error and informational messages are recorded in the log file, and trace
messages and their corresponding trace levels (0 to 5) are recorded in a trace file.
For details about logging and trace levels, see [Chapter 6, “Troubleshooting and|
ferror handling,” on page 49,

You configure both the log and trace file names, as well as the trace level, in
Connector Configurator Express. For details about this tool, see
[“Connector Configurator Express,” on page 73.|

Note that the ODA has no logging capability. Error messages are sent directly to
the user interface. Trace files and the trace level are configured in Business Object

Chapter 3. Configuring the adapter 21



Designer Express. The process is described in [‘Configure the agent” on page 38,
The ODA trace levels are the same as the connector trace levels, defined in
[‘Tracing” on page 50
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Chapter 4. Understanding business objects

This chapter describes the structure of business objects, how the adapter processes
the business objects, and the assumptions the adapter makes about them.

The chapter contains the following sections:

* |"Defining metadata”|

+ [“Connector business object structure” on page 24|

» ["Mapping attributes: COM, Java, and business object” on page 29|

» [“Sample business object properties” on page 31|

* ["Generating business objects” on page 35|

Defining metadata

The connector for COM is metadata-driven. In the WebSphere Business Integration
Server Express system, metadata is defined as application-specific information that
describes a COM application object’s data structures. The metadata is used to
construct business object definitions, which the connector uses at run time to build
business objects.

After installing the connector, but before you can run it, you must create the
business objects definitions. The business objects that the connector processes can
have any name allowed by the integration broker. For information about naming
conventions, see Naming Components Guide.

A metadata-driven connector handles each business object that it supports
according to the metadata encoded in the business object definition. This enables
the connector to handle new or modified business object definitions without
requiring modifications to the code. New objects can be created through the Object
Discovery Agent (ODA) in Business Object Designer Express. To modify an
existing object, use Business Object Designer Express directly (without going
through the ODA).

Application-specific metadata includes the structure of the business object and the
settings of its attribute properties. Actual data values for each business object are
conveyed in message objects at run time.

The connector makes assumptions about the structure of its supported business
objects, the relationships between parent and child business objects, and the format
of the data. Therefore, it is important that the structure of the business object
exactly match the structure defined for the corresponding COM object or the
adapter will not be able to process business objects correctly.

If you need to make changes to the business object structure, make them to the
corresponding object in COM and then export the changes to the type library for
input into the ODA.

For more information on modifying business object definitions, see the Busines
Object Development Guide.
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Connector business object structure

The connector processes business objects used by COM components. This section
describes the key concepts related to the structure of business objects processed by
the COM connector.

Attributes

For each attribute present in a COM component defined in a type library file (.tlb,
.dll, .olb, .ole, or .exe), a corresponding business object attribute is generated by the
ODA. The type library file contains interfaces, each with methods and properties. It
is used by the ODA to compile proxy object definitions.

If an attribute in the COM class is not a simple attribute, and instead is a
component, then the BO attribute maps to a child object whose definition matches
the corresponding component in the COM object.

Business objects can be flat or hierarchical. A flat business object only contains
simple attributes, that is, attributes that represent a single value (such as a string)
and do not point to child business objects. A hierarchical business object contains
both simple attributes and child business objects or arrays of child business objects
that contain attribute values.

A cardinality 1 container object, or single-cardinality relationship, occurs when an
attribute in a parent business object contains a single child business object. In this
case, the child business object represents a collection that can contain only one
record. The attribute type is the child business object.

A cardinality n container object, or multiple-cardinality relationship, occurs when
an attribute in the parent business object contains an array of child business
objects. In this case, the child business object represents a collection that can
contain multiple records. The attribute type is the same as that of the array of child
business objects.

Methods

For each method defined in the COM type library file, an attribute is created in the
business object. The attribute type is a child BO containing attributes that represent
method parameters. The attributes of the child BO appear in the exact same order
as the parameters of the COM method. The child BO also has a Return_Value
attribute, appearing last in the order of arguments, that represents the result of the
COM method call. These attributes (of the child BO) can be simple type or object
type (complex), depending on the type of the method parameter or return value.
The return value is always last in the order of arguments.

Note that the only non-alphanumeric character used in a COM identifier name is
the underscore (_), which is resolved to an underscore in the corresponding
business object. However, if the underscore appears at the start of the COM
identifier name, which WebSphere Business Integration Server Express format does
not allow, the ODA resolves the underscore to the string BBB_.

Application-specific information

Application-specific information provides the connector with application-
dependent instructions on how to process business objects. If you extend or modify
a business object definition, you must make sure that the application-specific
information in the definition matches the syntax that the connector expects.
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Application-specific information is represented as a name-value pair and can be
specified for the overall business object, for each business object attribute, and for
each verb.

Business object-level ASI

Object-level ASI provides fundamental information about the nature of a business
object and the objects it contains. describes the business object-level ASI of
business objects that represent proxy objects.

Note: ASI names are not recognized for business objects that represent methods,
method parameters, and method return values. For details about business

object attributes created for methods of COM objects, see
_

Table 4. Object-level ASI

Object-level ASI Description
proxy_class= The name of the proxy class that the business object
<nameOfProxyClass> represents. Use this ASI to map a proxy class to a

business object. You must specify this using valid Java
Package notation (for example, java.lang.Vector).

auto_load or write=true Indicates that a business object represents a record
structure that is used both as an argument and as a return
value. This ASI tells the adapter to write to the proxy
object (WriteToProxy) before the function call on
arguments for child object arguments, and then read the
proxy object (LoadFromProxy) after the function call
returns a value.

Verb ASI

Every business object contains a verb. The verb describes how the data in the
business object should be handled by the receiving application.

The verb ASI contains a sequence of attribute names, each of which contains a
method for the generic business object handler to call. Typically, the method to be
invoked belongs to the object itself (versus belonging to a parent of the business
object), in which case you specify the method in the object’s verb ASI. For
example, a component that has the method IncrementCounter would require that
you specify that method in the corresponding business object’s verb ASL

If the method to be invoked belongs to a parent in the business object hierarchy,
then that parent can be referenced by prefixing the method name with the PARENT
tag.

For example, [Figure 4 on page 26|illustrates a business object hierarchy whereby
ContactDetails is a child object of Contact, which itself is a child of
PSRCustomerAccount.
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PSRCustomerAccount

ContactDetails

Figure 4. Business object hierarchy and verb ASI

If a method that belongs to PSRCustomerAccount is called on the ContactDetails
business object, then the verb ASI for ContactDetails represents the business object
hierarchy as follows:

PARENT.PARENT.<methodName>

If the method belongs instead to the Contact business object, then the verb ASI for
ContactDetails must be set as:

PARENT . <methodName>

Note that only methods that belong to parent objects within the hierarchy can be
called. Furthermore, a parent business object cannot invoke a child’s method.

The connector developer determines the COM operations assigned to the verb.
Supported verbs include:

* Create
* Delete
* Retrieve
* Update

The following keywords can be used in the verb ASI sequence of attribute names:

Table 5. Keywords allowed in verb ASI

Keyword Description

LoadFromProxy= <attributeName> Calls the getter method for the specified proxy
object attribute, thus loading the attribute from the
proxy to the business object.

WriteToProxy = <attributeName> Calls the setter method for the specified proxy
object attribute, thus writing the attribute value
from the business object to the corresponding
proxy object.

LoadFromProxy (no attribute name) Calls all getter methods for non-method attributes
on the current BO from the proxy object.

WriteToProxy (no attribute name) Calls all setter methods for non-method attributes
on the current BO to the proxy object.
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Table 5. Keywords allowed in verb ASI (continued)

Keyword Description

CBOH=<custom BO handler className> |The class name of a custom BO handler, in cases
where the generic BO handler is not used. For
information about custom BO handlers, see
[’Custom business object handlers” on page 8.|

For a given object, you can specify the four supported verbs (Create, Retrieve,
Delete, and Update) and assign as actions of each verb n plus two methods, where
n equals the number of methods in the corresponding COM component. The two
additional methods are those supported by the connector (LoadFromProxy and
WriteToProxy), defined in [Table 5 on page 26

Attribute-level ASI

The attribute-level ASI of a business object can be for complex attributes, which
contain child objects, and simple attributes. For a complex attribute, the ASI varies,
depending on whether the contained child is a property or a method of an object.
The mapping of all the attribute-types in the original COM type library to the
ODA-generated business object is defined in|Table 9 on page 29}

describes the ASI for simple attributes. A simple attribute is always a
non-child, for example a boolean, string, or integer value.

Table 6. Attribute-level ASI for simple attributes

Attribute Description
Name Specifies the business object field name.
Type Specifies the business object field type. See[Table 9 on page 29 for details about mapping

COM component types to Java proxy types and business object attribute types.

MaxLength Not used.

IsKey Each business object must have at least one key attribute, which you specify by setting
the key property to true for an attribute. Note that this attribute is used by Business
Object Designer Express, rather than by the connector.

IsForeignKey Specifies that the connector should check whether or not the object must be stored in
the per call object pool (see Step .

IsRequired Not used.

AppSpecInfo Holds the original Java type. This attribute is formatted
as follows:

property=<propertyName>, type=<typeName>

property is the name of the COM object property. Use this name-value pair to
capture the original COM object property name.

type is the Java type of a simple attribute. See [Table 9 on page 29| for details
about mapping COM component types to Java proxy types and business object
attribute types.

This attribute should be set to proxy if the attribute is a business object. If it
does not map to a business object and is not intended to be de-referenced, as

in the case of a simple attribute, you can specify type=PlaceholderOnly. This
tells the BO handler to not de-reference and not populate the attribute. The
attribute can thus continue to be used as part of a multi-call flow if it is marked
as a foreign key (IsForeignKey is checked), or if use_attribute_value is set to

a compatible value.

Chapter 4. Understanding business objects 27



Table 6. Attribute-level ASI for simple attributes (continued)

Attribute

Description

DefaultValue

Not used.

describes the ASI for complex attributes containing child objects that are
not methods.

Table 7. Attribute-level ASI for attributes containing non-method child objects

Attribute

Description

type

The type of the contained object. Set to proxy if the type is a business object.

ContainedObjectVersion

Not used.

Relationship

Specifies that the child is a container attribute. Set to Containment.

IsKey Not used
IsForeignKey Not used
Is Required Not used

AppSpecificlnfo

Holds the original COM application field Name. This attribute is
formatted as follows:

property=propertyName, use_attribute_value=<(optional)BOName.AttributeName>,
type=<typeName>

property is the name of the COM object property. Use this
name-value pair to capture the original COM object property
name. In the case of an attribute that holds an argument to a
method, do not set a value for property, as the argument does
not have a name and is simply an argument of any standard

type.

use_attribute_value is the business object name formatted

as BOName.AttributeName. Setting this ASI causes the adapter
to access the attribute from the per call object pool. Note that
this value is not set in the ODA when you create the business
object, but rather via Business Object Designer Express.

type is the Java type of a property. This should be set to proxy

if the attribute is non-simple, in other words, if it holds a business
object (the corresponding COM type is IDispatch*. See

[Table 9 on page 29 for the mapping of types across COM, Java,
and business objects.)

Cardinality

Set to 1.

describes the ASI of complex attributes containing child objects that are
methods.

Table 8. Attribute-level ASI for attributes containing method child objects

Attribute Description
Name The business object field name
type The business object.

ReTlationship

Set to Containment, indicating that this is a child object.

IsKey

Set to true if the attribute name equals UniqueName, otherwise it is set to false.

IsForeignKey

Set to false.
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Table 8. Attribute-level ASI for attributes containing method child objects (continued)

Attribute

Description

Is Required

Set to false.

AppSpecificInfo Holds the original COM application field name, which represents the name
of the method call placed to the external COM server. This attribute is
formatted as:
method_name=<nameOfMethod>

Cardinality Set to 1.

Note that methods have arguments and return values. Arguments and return
values can be complex (containing child objects) or simple.

Mapping attributes: COM, Java, and business object

Table 9. Object mapping:

This section provides a list of the COM types defined in a type library and their
corresponding Java constructs and business object attributes. For all business object
attributes that are not child business objects, the data type is String. In a business
object, the ASI holds the actual data type of the attribute and is used when
invoking methods against the Java proxy object.

For details about business object ASI, see [“ Application-specific information” on|

Note: If a COM type is not supported by the COMProxy interface tool, then it is

not supported by the connector.

COM, JAVA, and business object

COMProxy Business Attribute ASI
COM type Java primitive |Java boxed internal object type=
Float float Float VT_R4 Float float
Float* float[] Float[] VT_R4 | Float float_refererence
VT_BYREF
BSTR No primitive String VT_BSTR String String
type exists
BSTR* No primitive String|[] VT_BSTR | String String_reference
type exists VT_BYREF
Int int Integer VT_I14 Integer int
int* int[] Int[] VT_I4 | VT_BYREEF |Integer int_reference
IDispatch* No primitive Object VT_DISPATCH Business proxy
type exists object
IDispatch** No primitive Object(] VT_DISPATCH | Business ArrayOf_proxy
type exists VT_ARRAY object
Short short Short VT_I2 Integer short
Short* short([] Short[] VT_I2 | VT_BYREEF |Integer short_reference
VARIANT No primitive Object VT_VARIANT String variant
type exists
VARIANT_BOOL boolean Boolean VT_BOOL Boolean boolean
VARIANT_BOOL* boolean([] Boolean([] VT_BOOL | Boolean boolean_reference
VT_BYREF
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Table 9. Object mapping:

COM, JAVA, and business object (continued)

COMProxy Business Attribute ASI
COM type Java primitive |Java boxed internal object type=
Long int Integer VT 14 Integer int
Long* int[] Integer VT_14 | VT_BYREEF |Integer int_reference
CURRENCY long Long VT_CY Integer Tong
CURRENCY* long(] Long|] VT_CY | Integer Tong_reference
VT_BYREF
DATE No primitive java.util.Date VT_DATE Date Date
type exists
DATE* No primitive Date[] VT_DATE | Date Date_reference
type exists VT_BYREF
double double Double VT_R8 Double double
double* double[] Double[] VT_RS8 | Double double_reference
VT_BYREF
unsigned char byte Byte VT_UI1 Integer byte
unsigned char* bytel[] Byte[] VT_UIT | Integer byte_reference
VT_BYREF
Decimal No primitive Not supported | Not supported Not Not supported
type exists supported
Decimal* No primitive Not supported | Not supported Not Not supported
type exists supported
hyper No primitive Not supported | Not supported Not Not supported
type exists supported
hyper* No primitive Not supported | Not supported Not Not supported
type exists supported
Small No primitive Not supported | Not supported Not Not supported
type exists supported
Small* No primitive Not supported | Not supported Not Not supported
type exists supported
SAFEARRAY (type) typel] Typel] VT_ARRAY Cardinality |Array0f_type
n business
object child
with single
attribute
Enum int Integer VT_INT Integer int

Note: In cases where the attribute is not intended to be de-referenced, the ASI
type=PlaceholderOnly should be used. This tells the adapter to not populate
this attribute. The attribute may still be used as part of a multi-call flow if it
is either marked as a foreign key (IsForeignKey is set to true), or has the
ASI use_attribute_value pointing to a compatible attribute.

Array types

Note the following about array types:

* To use an array type, specify an ASI of type=Array0f <value>, where value is
one of the attribute ASI values listed in [Table 9 on page 29 For example,
type=Array0f_int specifies an array of int variables. These are mapped to a
cardinality n business object that contains the element.
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* An Object array (Object[]) in Java has a corresponding ASI type of
ArrayOf_proxy. The processing of proxy objects is done against every element of
the array. If the proxy array is an argument to a function, verb processing will
occur on every object in the array before executing the method. If the array is a
return value, verb processing will occur on every object in the array after
executing the method.

* A sized array may be used as input but not as output.
¢ A SafeArray is supported as both an input and a return value.

Sample business object properties

This section provides the following examples that illustrate how the adapter
processes a business object:

+ [“Connector call sequence sample”|

* [“Business object sample”]

Connector call sequence sample

The following sample code illustrates connector code that writes a simple message
("Hello World") to WebSphere MQ.

/**********************************************

*Create the MQSession object and access the MQQueueManager and (local) MQQueue
**********************************************/

MQSession MQSess = new MQSession();
iDispatch = MQSess.AccessQueueManager("COMTest");
MQQueueManager QMgr = new MQQueueManager(iDispatch);

QMgr.Connect();
MQQueue MyQueue=new MQQueue(QMgr.AccessQueue 4("SYSTEM.DEFAULT.LOCAL.QUEUE",17));

MyQueue.Open();
MQMessage PutMsg = new MQMessage(MQSess.AccessMessage());

//write a string to the message
PutMsg.WriteString("Hello World";);

//put the message on the queue
MyQueue.Put (PutMsg);
MyQueue.Close();
QMgr.Disconnect();

Business object sample

The following sample screens illustrate the business object structure and
application specific information required for the code in the [“Connector calll
kequence sample”| to function properly. The business object illustrated in these
sample screens uses the Create verb.
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= M()_M0Q5ession:Local Project | [O0] x|
General I Aftributes ]

Buzsineszs Object Level Application-specific information:

Oy sE=motes Seszion

Supported Werbs:

Mame i Application-specific information
1 |creste AcceszQueueilanager
2 |Delete
3 |Retrieve
4 |Update
a

Figure 5. Business object level ASI and supported verbs

illustrates the top-level business object, MQ_MQSession, which corresponds
to the first object created in the method sequence. The Create verb ASI contains
AccessQueueManager, which is the function that will allow access to an
MQQueueManager object.

AccessQueueManager returns an object of type Integer. This object can be passed
into the constructor of MQQueueManager to create an instance of the MQQueueManager
proxy.

Note that the business object level ASI contains the string
proxy_class=mqtest.MQSession, which is the proxy object that represents the COM
component for this business object. For a description of the proxy_class ASI, see
[Table 4 on page 25}
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= MQ_MQSession:Local Project !E
General I Aftributes l

Fos MName Type Key |Foreign [REdui | carg  |Maximu | petaut App Spec Info
1 |1 H AccessQueueManader MQ_AccessQueue: | [ - r 1 method _name=AccessQuauehanager
11 114 input String e r r 255 type=String
12 |12 B Return_valie MQ_MaQueuehana| [ r r 1 type=proxy
121121 B AccessQueus 4 MQ_AccessQueus | [ r r 1 method_name=4ccessQuele
121121, name String ~ r r 255 type=String
121124, CpenOptions Integer r I - property=OpenOptions;type=int
12,1121, B Return_Walie ME MQQueLE r r r 1 type=promy
121124, name String i - Il 255 property=name type=String
121124, Open String r r Il 255 method_name=Cpen
12 124, H Gat M MEGusus Get| [ r iy methodl_name=Get
12,0124, B Put MQ_MAGueus Put | [ r [y method_name=Put
12 121, Hmsg MQ_MaMessage v r T 1 type=proxy
12 124, HiriteString  [MQ_WriteString r r . method_name=itsString
12,1921, value String i~ r ' 255 type=String
12 124, OhjectEventld |String
12124, OhjectEverld  |String
12 124, ObjectEvertld  [String
12,1921, Close String T r T 255 method name=Close
12 124, ObjectEventld String
121121, OhjectEventld String
121122 Commit String ~ Il r 255 methad name=Camimit
121123 Connect String ird r r 255 method. name=Connect
121124 Discannect String ird r I 255 method_name=Disconnect
121125 ObjectEventld String
13 113 ObjectEventld String
2 |2 |ObjectEventld Siring
I ] Il r Il 255
< | i

Figure 6. Business object hierarchy for the MQSession object

ﬂlustrates the business object hierarchy, from the parent (MQSession) all the
way down to the lowest-level child.

AccessQueueManager is a method that returns an iDispatch pointer, which is
mapped to MQQueueManager (designated as the Return_Value attribute in the
business object). MQQueueManager is a proxy object, represented by the child object

MQ_MQQueueManager in the business object structure shown in

- MQ_MOQQueueManager:Local Project *

General I Aftributes I

Buziness Object Level Application-specific information:

IpmH_l,l_cIass=mqtest.MGQueueM anager

Supported Werbs:

Mame T Application-specific informstion
1 |[creste Connect, Access@Queue_4 Disconnect
2 |Delete
3 |Retrigve
4 |Updete
5

Figure 7. Method call sequence for MQ_MQQueueManager

ﬂlustrates the method sequence on the verb Create of the business object
MQ_MQQueueManager.
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The sequence is made up of the following three methods:
1. Connect

2. AccessQueue 4

3. Disconnect

Note that in the BO structure illustrated in [Figure 6 on page 33| AccessQueue_4
returns a proxy object, called MQ_MQQueue. Therefore, the connector will process
this returned proxy object (which is the child of AccessQueue_4) after executing
AccessQueued and before executing Disconnect, the third and last method in the call
sequence of MQ_MQQueueManager.

~/MQ_MQQueue:Local Project * N [=] 3
General I Attributes I

Business Object Level Application-specific information:

Ipmx_l,l_class:mqtest.MQGueue

Supported Yerbs:

Mame \_ Application-specific informstion
Creste Open;Put; Close
Delete

Retrieve
Upclate

th| & L) k| =

Figure 8. Method call sequence for MQ_MQQueue

|l_3igure 8| illustrates the method sequence for MQ_MQQueue, the child of AccessQueue_4
(Figure 6 on page 33). The call sequence is made up of the following three

methods:
1. Open
2. Put

3. Close

The Put method takes MQMessage as an argument, so the connector must create the
MQMessage object (and execute methods on it) before executing the Put method.

Note that the recursive nature of the connector’s processing behavior means that
Put is executed before the Disconnect method of MQ_MQQueueManager
, the parent of AccessQueue_4 (Figure 6 on page 33).
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~ MQ_M0QMessage:Local Project * _ 3] x|
General I Aftributes I

Buziness Object Level Application-specific information:

Ipro:-:y_class=mqtest. MOMeszage

Supported Werbs:

Mame \_ Application-specific informstion
Create Wytite String
Delete
Retriewe

Update

| =] ] b3 =

Figure 9. Method call sequence for MQMessage

ﬂlustrates the method sequence for MQMessage. This sequence calls only the
WriteString method, which takes a simple string as an argument. In this example,
the argument is the "Hello World” message. The message is written to WebSphere
MQ and then the connector continues processing methods in the recursive
sequence described in this section: after calling WriteString, the connector
"backtracks” up the hierarchy and executes the Close method of MQ_MQQueue

(Figure 8 on page 34), followed by the Disconnect method of MQ_MQQueueManager
(Figure 7 on page 33).

Generating business objects

Each time an event occurs during run time, a COM application sends a message
object containing object-level data and information about the type of transaction.
The connector maps this data to the corresponding business object definition, to
create an application-specific business object. The connector sends these business
objects on to the integration broker for processing. It also receives business objects
back from the integration broker, which it passes back to the COM application.

Note: If the object model in the COM application is changed, use the ODA to
create a new definition. If the business object definitions in the integration
broker repository do not match exactly the data that the COM application
sends, the connector is not able to create a business object and the
transaction will fail.

Business Object Designer Express provides a graphical interface that enables you to
create and modify business object definitions for use at run time. For details, see
(Chapter 5, “Creating and modifying business objects,” on page 37
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Chapter 5. Creatlng and modifying business objects
“Overview of the ODA for COM”|

* [“Generating business object definitions”]

* |“Specifying business object information” on page 42|

* |“Uploading business object files” on page 47

Overview of the ODA for COM

An ODA (Object Discovery Agent) enables you to generate business object
definitions. A business object definition is a template for a business object. The
ODA examines specified application objects, “discovers” the elements of those
objects that correspond to business object attributes, and generates business object
definitions to represent the information. Business Object Designer Express provides
a graphical interface to access the Object Discovery Agent and to work with it
interactively.

The Object Discovery Agent (ODA) for COM generates business object definitions
from metadata contained in COM type library files. The Object Discovery Agent
automates the process of creating these definitions. You use the ODA to create
business objects and Connector Configurator Express to configure the connector to
support them. For information about Connector Configurator Express, see
[Appendix B, “Connector Configurator Express,” on page 73

Generating business object definitions

This section describes how to use the COM ODA in Business Object Designer
Express to generate business object definitions. For information on launching and
using Business Object Designer Express, see the Business Object Development Guide.

Starting the ODA

The ODA can be run from any machine that can mount the file system on which
the metadata repository (the type library files) resides, using the

start_ COMODA .bat start file. This file contains start parameters, including the
paths to certain required COM and connector jar files. These jar files must also be
accessible from the machine on which you are running the ODA.

The ODA for COM has a default name of COMODA. The name can be changed by
changing the value of the AGENTNAME variable in the start script.

To start the ODA, run this command:

start_COMODA

Note that this startup file requires that the directory of the Java compiler
(javac.exe), be included in the PATH environment variable. For example, if
Jjavac.exe is in the directory c:\jdk131_02\bin, then include the following line in
start_COMODA.bat:

set PATH=c:\jdk131_02\bin;%PATH%

Or, add the string c:\jdk131_02\bin in the System PATH variable.
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Running Business Object Designer Express

Business Object Designer Express provides a wizard that guides you through the
steps to generate a business object definition using the ODA.

At any point while using the wizard screens, click Back to go to the previous
screen, Next to go to the next screen, or Cancel to cancel the current screen and
exit out of the wizard.

The wizard steps are as follows:

Select the agent
To select the agent, follow these steps.
1. Start Business Object Designer Express.

2. Click File > New Using ODA. The Business Object Wizard - Step 1 of 6 - Select
Agent screen appears.

3. Select the AGENTNAME (specified in the start COMODA script) appended
with the [hostname:port] from the Located agents list and click Next. (You may
have to click Find Agents if the desired agent is not listed.)

=10 x|t

Prezs "Find Agentz" ta locate ODAz Lacated agents:
in wour zubnet (3026, 234 ). Yo
will be given an estimate of the time COMODA [local host:57037]

required to complete the operation
and a means to cancel the zearch.

[f wou hiave an ODA that iz mnning
an a machinge outzide subnet

9.26. 234 waw prezs 'Configure
Digooveny' to include that machine
in the search.

Configure Dizcovern |

Eind Agents |

Agent's name: To be dizcoverad

Agent's host: |

Part: li

| Cancel

Figure 10. Select Agent Screen

Configure the agent

After you click Next on the Select Agent screen, the Business Object Wizard - Step 2
of 6 - Configure Agent screen appears. [Figure 11 on page 39| illustrates this screen
with sample values.
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Business Ohject Wizard - Step 2 of 6 - Configure Agent

— Profiles

Current profile: ISampIe vI

Sawe | Hew | Bemove |
Property Value Type Descriptior
1 TypeLibraryPat | CTempDocsiCOkEabjsry 1l |E| Cipher text | Select the lacal type litbt
2  |Packagefame |Siebel String Enter walue of package
3 | SaveToDirector|CTempDocs El Directory | Select the folder in whi
4 | JarFileMame Siehel jar String Enter value of jar file ns
5 |BOPrefix Siehel String Enter walue of business

E |TraceFileMsime |BIA_COMODAtrace.txt String Mame of the trace file.
7 |TracelLevel 5 Integer Trace level for the ager
8 |MeszageFile  |BIA_COMODAAGent fxt String Mame of the error and ¢
1] | |
< Back Hext > Cancel |

Figure 11. Configure Agent screen

The properties you set on this screen are described in [Table 10
Table 10. Configure Agent properties

Property name

Default value

Type

Description

TypelLibraryPath

None

String

(required) The path to the local type
library file (.tlb, .dll, .ole, .olb, or .exe) that
defines the COM interface. Browse the list
of file paths and select the pathname.

PackageName

None

String

(required) The package in which all the
proxy files generated by COMProxy are
stored. COMProxy generates the Java
proxy objects that the connector requires to
invoke COM components.

SaveToDirectory

None

String

(required) The directory in which the
package specified in PackageName is stored.
Browse the list of file paths and select the
pathname.

JarFileName

None

String

(required) The jar file in which the proxy
classes generated by the ODA will be

stored. Note that the ODA determines the
directory location where this file is placed.

BOPrefix

None

String

The prefix that the ODA will add to the
names of the business objects it generates.

TraceFileName

None

String

The name of the trace message file; the
default value is BIA_COMODAtrace.txt.

Tracelevel

Integer

(required) The tracing level (from O to 5)
for the Agent. For details about tracing
levels, see [“Tracing” on page 50.|
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Table 10. Configure Agent properties (continued)

Property name Default value |Type Description

MessageFile None String (required) The name of the message file
that contains all the messages displayed by
the ODA. For COM, the name of this file is
BIA_COMODAAgent.txt. If you do not
correctly specify the name of the message
file, the ODA will generate the error
"Cannot find or read message file.”

You can save all the values you enter on the Configure Agent screen (Figure 11 on|
to a profile. Instead of retyping the property data next time you run the

ODA, you simply select a profile from the drop-down menu and re-use the saved
values. You can save multiple profiles, each with a different set of specified values.

1. On the Configure Agent screen (Figure 11 on page 39), click the New button in
the Profiles group box to create a new profile.

2. Type the value of each property, as defined in [Table 10 on page 39}

Note: If you use an existing profile, the property values are filled in for you,
though you can modify the values as needed.

3. Click the Save button in the Profiles group box to save the new or updated
values.

Select a business object

The Business Object Wizard - Step 3 of 6 - Select Source screen appears, as illustrated
in The screen lists the components that have been defined in the COM
type library file. Use this screen to select any number of COM components for
which the ODA will generate business object definitions.

Business Ohject Wizard - Step 3 of 6 - Select Source

From the tree below, select the source nodes from which the Dezsigner will generate Business

Objects. Click "Mest" to continue. s i alieet feiead |

Mame Diezcription
- SiebelApplication COMponent
#- §SiebelBusComp COMponent
El- SiebelBusObject COMponent
GetBusComp Method
name Method
- SiebelPropertyS et COMponent
[#-- SiebelService COMponent
| |
< Back Mest > Cancel

Figure 12. Select Source screen
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1. If necessary, expand a COM component to see a list of methods of the
component.

2. Select the COM object(s) you want to use. In [Figure 12 on page 40} the name
method is selected.

3. Click Next to continue to the next screen in the wizard.

Confirm the object selection
The Business Object Wizard - Step 4 of 6 - Confirm source nodes for business object
definitions screen appears. It shows the object(s) you selected.

Business Object Wizard - Step 4 of 6 - Confirm source nodes for busines... [B= E3

Buziness objects are about ta be generated using the source nodes summarized below,
Click "Mext" to start generating the objects or click "Back" to change vour selection,

Mame Description
- SiebelBusObject COMponent
S hame Method

| |+

< Back Mest » Cancel

Figure 13. Confirm source node screen

Click Back to make changes or Next to confirm that the list is correct.

The Business Object Wizard - Step 5 of 6 - Generating business objects... screen appears
with a message stating that the wizard is generating the business objects.

Note that if you selected a method (see [“Select a business object” on page 40)), that
has a parameter or return value with a Java type of Object or Object[], the ODA
displays the BO Properties screen, illustrated in [Figure 14 on page 42} Use this
screen to map an object of such a type to either a COM component or String. The
drop-down menu in the Value column lists only components from the current type
library. For a complete list of the mapping of COM and Java types to business
object ASI, see [Table 9 on page 29|
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+ BO Properties - Parameter of type Object encountered

COMponenthlame _|— Select component for the specified Obj

Figure 14. BO Properties screen

The ODA assigns a name to this screen that provides details about the component
name, the method name of the component that the ODA is currently processing,
and the name of the method parameter whose data type is Object or Object[].

Specifying business object information

You can specify the verbs that are valid for the object and the method sequence of
a given verb on the object. This section describes how to specify this information,
using the ODA with Business Object Designer Express. For a detailed description
of these categories of information and what they mean for business object structure
in the COM connector, see [Chapter 4, “Understanding business objects,” on page]

Selecting verbs

After the BO Properties screen, illustrated in [Figure 14] the BO Properties — Select
Verbs for component screen appears. [Figure 15 on page 43| illustrates this screen for
the name business object created in [Figure 12 on page 40}
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i BO Properties - Select verbs for component - SiehelBusObject E

Property Value Type Description
1 “erbs String Select supported verbs

Figure 15. Select verb for component screen

On this screen you specify the verbs that the business objects supports. The ODA
allows you to specify the four supported verbs (Create, Retrieve, Delete, and
Update). To specify additional verbs beyond the supported four, or to edit verb
information after you create a business object, use Business Object Designer
Express.

For details about business object verbs for the COM connector, see

1. In the Value list for the Verbs property, select the verbs that you want the
business object to support. You can select one or more verbs. You can also
deselect a verb at any time.

2. Click OK.

Specifying the verb ASI

The ODA allows assigning as actions of each verb n plus two methods, where n
equals the number of methods in the corresponding COM component. The two
additional methods are those supported by the connector (LoadFromProxy and
WriteToProxy). For each verb selected in Step El of [“Selecting verbs” on page 42)a
separate window appears where you specify the method sequence that must be
executed for the verb.

[Figure 16 on page 44| illustrates this screen for the Create verb of the name business
object created in [Figure 12 on page 40|and [Figure 13 on page 41}
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1 BO Properties ER

Current Werb -Create Component name - SiebelBusObject

Property Value Type Description
1 MethodSequence|LoadFromProxy String Select the method sequence
2 MethodSequence|name String Select the method sequence
3 MethodSequence [0S 2T String Select the method sequence

« | |

Figure 16. Setting the verb method sequence

1. In the Value list for the MethodSequence property, click the method that you
want the business object to execute first for the verb. In the method
sequence is as follows:

¢ The first method that will be executed in the sequence of methods for the
Create verb is LoadFromProxy.

* The second method in the sequence is name.

* The third method in the sequence is WriteToProxy.

The name method is provided by the Siebel business object component (defined
in the type library file). The LoadFromProxy and WriteToProxy methods are
provided by the ODA.

By specifying a method sequence for the verb, you are creating the verb ASI
that is associated with that verb. If necessary, this verb ASI can be modified
later using Business Object Designer Express.

2. Click OK.

For a list of the keywords supported by the COM verb ASI, see [Table 5 on page 26
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Open the business object in a separate window
The Business Object Wizard - Step 6 of 6 - Save business objects screen appears.

Business Object Wizard - Step 6 of 6 - Save business obhjects

Figure 17. Save business objects screen

You can optionally open the new business objects in separate windows within
Business Object Designer Express, or (after specifying a key for the top-level
business object) you can save the generated business object definitions to a file.

To open the business objects in separate windows

1. Select Open the new BOs in separate windows.

2. Click Finish. Each business object appears in a separate window where you can
view and set the ASI information for the business objects and business object

verbs you just created. For details, see [‘Selecting verbs” on page 42| and
[“Specifying the verb ASI” on page 43|

To save the business objects to a file (only after you specify a key for the
parent-level business object, as illustrated in [Figure 18 on page 46):

1. Select Save a copy of the business objects to a separate file. A dialog box
appears.

2. Type or select the location in which you want the copy of the new business
object definitions to be saved.

Business Object Designer Express saves the files to the specified location.

If you have finished working with the ODA, you can shut it down by checking
“Shutdown ODA COM ODA” before clicking Finish.
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Specifying the attribute-level ASI

Business Object Designer Express displays the attributes for the business object, as
illustrated in [Figure 1;§l For details about the attribute-level ASI in the COM
connector, see |[”Attribute-level ASI” on page 27/

The attributes are listed on the Attributes tab in the order in which they appear in
the business object structure, as defined by the numeric value in the Pos column.
Simple COM object attributes are represented as simple attributes and their ASI
contains the original COM attribute name and type.

For each attribute, the screen provides the name of the attribute, its type, and the
ASI information. For example, the name attribute of the business object has an ASI
that maps the attribute to the original COM component method. In this example,
the original method is indicated under the App Spec Info column, by the
method_name=name ASI.

In addition, name (a child business object) has the following child object attributes:

* errCode, which is a parameter of the original method in the COM type library.
This attribute has an ASI of type, which in the COM type library file is set to
short_reference. In the business object, the type is mapped to Integer.

* return_value, which is used to capture the return value of the name method. In
the COM type library file, the method is defined as having a return value of
type BSTR, and in the business object ASI, the type is set to String. Note that if a
method in the COM type library does not return a value, the return_value
attribute is not included in the list of business object attributes.

Siebel_SiebelBusObject:Local Project *

General l Attributes ]
Poz Mame Type Key |Foreign RECIIUi Card M‘?Xi"m’l Detautt App Spec Info

T N H name Siebel_name - - I 1 method_name=name
11 |14 efrCode Integer ™ - - type=short_reference
12112 Return_Yalue String ™ - I 255 type=String
13 1z ChjectEventld String
2 |2 | ObjectEvertld String
3 s Il Il - 255
| | -

Figure 18. Setting the attribute AS/

On this screen, you should specify whether or not a parent-level object is a key
(which is required by the ODA for saving the business objects to a separate file).
You can also use this screen to set child object keys as needed and to specify the
following information:

* Is the attribute required for the connector to process the business object? If so,
click the Required check box.

¢ Is the maximum length of the attribute different from the value that appears in
the Maximum Length column.

* Does the attribute have a default value? If so, type the value in the Default
column.

Note: While you can create a business object through the ODA (running in

Business Object Designer Express) and set the parent level key(s), do not
configure the foreign key in this manner. The foreign key is non-ASI meta
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data and therefore must always be configured without the ODA (in Business
Object Designer Express, click File > New to create a new business object
without using the ODA).

Specifying the business object-level ASI

You can view and modify the business object-level ASI. For details about business
object-level ASI, see [“Business object-level ASI” on page 25|

The business object-level ASI is listed on the General tab. The ASI value that
appears in the field Business Object Level Application-specific information
contains the name of the proxy class that represents this business object. The
connector uses this information to map a proxy class to a business object.

This screen also lists all the verbs that are supported by the business object and
provides the ASI for each verb, as it was defined in [“Specifying the verb ASI” on|
If a verb ASI is blank, then a method sequence will not be executed for
that verb.

illustrates the business object-level ASI for the name business object. The
only verb that will execute a method sequence for this business object is Create,
which has a verb ASI with the method sequence illustrated here (it was originally
set in [Figure 16 on page 44).

Siehel_SiebelBusObject:Local Project *

General ] Attributes I

Business Object Level Application-specific information:

oy bel SiebelBuslbjec

Supported Yerbs:

Name \_ Application-specific information
1 |Creste LoadFromProxy; name;Write ToProxy
2 |Delete
3 |Retrieve
4 |Updste
&

Figure 19. Setting the business object level ASI

On this screen you can modify the ASI of the top-level business object and its
supporting verbs. Note that if you open a business object that contains attributes of
the child object type, the General tab presents the ASI of the top-level business
object, which you can modify. If you open a child business object in a separate
window, the General tab presents the ASI as that of a top-level object.

Uploading business object files

The newly created business object definition files must be uploaded to the
integration broker once they have been created. If you have saved your business
object definition files to a local machine and must upload them to the repository
on the server, refer to the System Implementation Guide.
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Chapter 6. Troubleshooting and error handling

This chapter describes how the adapter for COM handles errors. The adapter
generates logging and tracing messages. This chapter describes these messages and
provides troubleshooting tips. The chapter contains the following sections:

* [“Error handling”]|

* |"Logging” on page 50|
* [“Tracing” on page 50|

Error handling

All messages generated by the connector are stored in a message file named
BIA_COMConnector.txt. (The name of the file is determined by the LogFileName
standard connector configuration property.) Each message has a message number
followed by the message:

Message number
Message text

The connector handles specific errors as described in the following sections.

COM exception generated by COMProxy

The COMProxy interface tool can generate a variety of errors. For example, if the
COM application is down, or the COM call returns a failure, the COMProxy tool
throws an exception.

The connector handles such COMProxy exceptions by logging and returning a
FAIL code. The HRESULT of the COM call is contained in the COM exception. To
aid in debugging, the connector logs the HRESULT, and returns it in the message
field of the VerbProcessingFailed exception. The exception also contains
information about which call in the sequence failed.

ClassNotFound for proxy

When the Loader receives the proxy class name and tries to create a proxy object
of that class, an exception is raised if it cannot find the class. The connector logs
the error, which includes the name of the class not found, and returns a FAIL code.

InstantiationException in Loader

When the Loader receives the proxy class name and tries to create a proxy object
of that class, an exception is raised if it cannot create the object instance. The
connector logs the error, which includes the class name of the object that cannot be
instantiated, and returns a FAIL code.

InstantiationException or ClassNotFound during setup of
factory or connection pool
A fatal exception is raised if one of the following occurs:

* The Agent Init() method cannot find the Factory class or Connection class
specified in the connector’s configuration properties.

¢ The Agent Init() method cannot instantiate a Factory or Connection object of the
specified class.
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The connector logs the error and returns an APP_RESPONSE_TIMEOUT code.

lllegal AccessException in Loader or Invoker

The connector raises an exception due to invalid code or improper access (public
or private) on a method by the COMProxy tool.

The connector logs the error and returns a FAIL code.

NoSuchMethodException in Invoker

The connector raises an exception if a method is specified on the business object
that does not exist in the corresponding proxy object.

The connector logs the error and returns a FAIL code.

InvocationTargetException in Invoker

The connector raises an exception when the COM application (with which the
connector is exchanging business objects) raises an exception.

The connector logs the error and returns a FAIL code.

Invalid argument (CXlgnore) in a method object in Invoker

The connector raises an exception when a method is included in the business
object’s verb ASI, but the arguments of that method have not been populated.

The connector logs the error and returns a FAIL code.

Cast failure or wrong attribute type

The connector raises an exception if a proxy object method takes or returns a
different data type than what has been specified in the business object.

The connector logs the error and returns a FAIL code.

Invalid verb ASI

The connector raises an exception if the verb ASI of the business object being
passed to it is formatted incorrectly or uses improper syntax. Examples of this
include a verb ASI that does not contain a proper method sequence, or a child
business object that specifies CBOH (custom BO handler) for an active verb.

The connector logs the error and returns a FAIL code.

Logging

All errors described in [“Error handling” on page 49| must be read from the
message file (BIA_COMConnector.txt).

Tracing

Tracing is an optional debugging feature you can turn on to closely follow
connector behavior. Trace messages, by default, are written to STDOUT. For more
on configuring trace messages, see the connector configuration properties in
[“Configuring the connector” on page 15.
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able 11{lists the recommended content for connector tracing message levels.

Table 11. Tracing messages content

Level

Description

Level 0

Use this level for trace messages that identify the connector version. No
other tracing is performed at this level.

Level 1

Use this level for trace messages that:
* Provide status information.
* Provide key information on each business object processed.

* Record each time a polling thread detects a new message in an input
queue.

Level 2

Use this level for trace messages that:

* Identify the BO handler used for each object that the connector processes.
* Log each time a business object is posted to the integration broker.

* Indicate each time a request business object is received.

Level 3

Use this level for trace messages that:

* Identify the foreign keys being processed, if applicable. These messages
appear when the connector has encountered a foreign key in a business
object or when the connector sets a foreign key in a business object.

* Relate to business object processing. Examples of this include finding a
match between business objects, or finding a business object in an array
of child business objects.

Level 4

Use this level for trace messages that:

* Identify application-specific information. Examples of this include the
values returned by the methods that process the application-specific
information fields in business objects.

* Identify when the connector enters or exits a function. These messages
help trace the process flow of the connector.

* Record any thread-specific processing. For example, if the connector
spawns multiple threads, a message logs the creation of each new thread.

Level 5

Use this level for trace messages that:

* Indicate connector initialization. This type of message can include, for
example, the value of each connector configurator property that has been
retrieved from the broker.

* Detail the status of each thread that the connector spawns while it is
running.

* Represent statements executed in the application. The connector log file
contains all statements executed in the target application and the value of
any variables that are substituted, where applicable.

* Record business object dumps. The connector should output a text
representation of a business object before it begins processing (showing
the object that the connector receives from the collaboration) as well as
after it finishes processing the object (showing the object that the
connector returns to the collaboration).
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Appendix A. Standard configuration properties for connectors

This appendix describes the standard configuration properties for the connector
component of WebSphere Business Integration Server Express adapters. The
information covers InterChange Server Express.

For information about properties specific to this connector, see the relevant section
in this guide.

New properties

These standard properties have been added in this release:
* AdapterHelpName

* ControllerEventSequencing

* jms.ListenerConcurrency

* jms.TransportOptimized

¢ TivoliTransactionMonitorPerformance

Standard connector properties overview

Connectors have two types of configuration properties:
 Standard configuration properties, which are used by the framework

* Application, or connector-specific, configuration properties, which are used by
the agent

These properties determine the adapter framework and the agent run-time
behavior.

This section describes how to start Connector Configurator Express and describes
characteristics common to all properties. For information on configuration
properties specific to a connector, see its adapter user guide.

Starting Connector Configurator Express

You configure connector properties from Connector Configurator Express, which
you access from System Manager. For more information on using Connector
Configurator Express, refer to the sections on Connector Configurator Express in
this guide.

Connector Configurator Express and System Manager run only on the Windows
system.

Configuration property values overview
The connector uses the following order to determine a property’s value:
1. Default
2. Repository for InterChange Server Express integration broker.
3. Local configuration file
4. Command line
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The default length of a property field is 255 characters. There is no limit on the
length of a STRING property type. The length of an INTEGER type is determined
by the server on which the adapter is running.

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s update
method determines how the change takes effect.

The update characteristics of a property, that is, how and when a change to the
connector properties takes effect, depend on the nature of the property.

There are four update methods for standard connector properties:

* Dynamic
The new value takes effect immediately after the change is saved in System
Manager. However, if the connector is in stand-alone mode (independently of
System Manager).

* Agent restart (InterChange Server Express only)
The new value takes effect only after you stop and restart the connector agent.

* Component restart
The new value takes effect only after the connector is stopped and then restarted
in System Manager. You do not need to stop and restart the agent or the server
process.

* System restart
The new value takes effect only after you stop and restart the connector agent
and the server.

To determine how a specific property is updated, refer to the Update Method
column in the Connector Configurator Express window, or see the Update Method
column in(Table 12 on page 55}

There are three locations in which a standard property can reside. Some properties
can reside in more than one location.

* ReposController
The property resides in the connector controller and is effective only there. If
you change the value on the agent side, it does not affect the controller.

* ReposAgent
The property resides in the agent and is effective only there. A local
configuration can override this value, depending on the property.

* LocalConfig
The property resides in the configuration file for the connector and can act only
through the configuration file. The controller cannot change the value of the
property, and is not aware of changes made to the configuration file unless the
system is redeployed to update the controller explicitly.

Standard properties quick-reference

[Table 12 on page 55| provides a quick-reference to the standard connector
configuration properties. Not all connectors require all of these properties, and
property settings may differ. .

See the section following the table for a description of each property.
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Note: In the Notes column in [Table 12} the phrase “RepositoryDirectory is set to
<REMOTE>" indicates that the broker is InterChange Server Express.

Table 12. Summary of standard configuration properties

Update
Property name Possible values Default value method Notes
AdapterHelpName One of the valid Template name, if valid, | Component Supported regional
subdirectories in or blank field restart settings.
<ProductDir>\bin\Data\ Include chs_chn,
App\Help that has a valid cht_twn, deu_deu,
<Regional Setting> esn_esp, fra_fra,
directory ita_ita, jpn_jpn,
kor_kor, ptb_bra,
and enu_usa (default).
AdminInQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/ADMININQUEUE restart only when the value
of DeliveryTransport
is JMS
AdminOutQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/ADMINOUTQUEUE restart only when the value
of DeliveryTransport
is JMS
AgentConnections 1 through 4 1 Component This property is valid
restart only when the value
of DeliveryTransport
is MQ or IDL, the value
of Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
AgentTraceLevel 0 through 5 0 Dynamic
for ICS;
otherwise
Component
restart
ApplicationName Application name The value specified for | Component
the connector restart
application name
CharacterEncoding Any supported code. ascii7 Component This property is valid
The list shows this subset: restart only for C++ connectors.
ascii7, ascii8, SJIS,
Cp949, GBK, Big5,
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
CommonEventInfrastruc true or false false Component
ture restart
CommonEventInfrastruc A URL string, for No default value. Component This property is valid
tureURL example, restart only if the value of
corbaloc:iiop: CommonEvent
host:2809. Infrastructure is true.
ConcurrentEventTrig 1 through 32,767 1 Component This property is valid
geredFlows restart only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is ICS.
ContainerManagedEvents | Blank or JMS Blank Component This property is valid
restart only when the value

of Delivery Transport
is JMS.
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Table 12. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update
method

Notes

ControllerEventSequenc
ing

true or false

true

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

ControllerStoreAndFor
wardMode

true or false

true

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

ControllerTraceLevel

0 through 5

Dynamic

This property is valid
only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is ICS.

DeliveryQueue

Any valid JMS
queue name

<CONNECTORNAME>
/DELIVERYQUEUE

Component
restart

This property is valid
only when the value
of Delivery Transport
is JMS.

DeliveryTransport

IDL or JMS

IDL when the value of
RepositoryDirectory is
<REMOTE>, otherwise
JMS

Component
restart

If the value of
RepositoryDirectory is
not <REMOTE>,

the only valid value for
this property is JMS.

DuplicateEventElimina
tion

true or false

false

Component
restart

This property is valid
only if the value of
DeliveryTransport is JMS.

EnableOidForFlowMoni
toring

true or false

false

Component
restart

This property is valid
only if the value of
BrokerType is ICS.

FaultQueue

Any valid queue name.

<CONNECTORNAME>
/FAULTQUEUE

Component
restart

This property is

valid only if the value
of DeliveryTransport
is JMS.

jms.FactoryClassName

CxCommon.Messaging.jms
. IBMMQSeriesFactory,
CxCommon.Messaging
.Jms.SonicMQFactory,
or any Java class name

CxCommon.Messaging.
jms.IBMMQSeriesFactory

Component
restart

This property is

valid only if the value
of DeliveryTransport
is JMS.

jms.ListenerConcurrency

1 through 32767

Component
restart

This property is

valid only if the value of
jms.TransportOptimized
is true.

jms.MessageBrokerName

If the value of
jms.FactoryClassName
is IBM, use
crossworlds.queue.
manager.

crossworlds.queue.
manager

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS

jms.NumConcurrent
Requests

Positive integer

10

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS
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Table 12. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
jms.Password Any valid password Component This property is valid
restart only if the value of
DeliveryTransport
is JMS
jms.TransportOptimized true or false false Component This property is valid
restart only if the value of
DeliveryTransport
is JMS and the value of
BrokerType is ICS.
jms.UserName Any valid name Component This property is valid
restart only if the value of
Delivery Transport is JMS.
JvmMaxHeapSize Heap size in megabytes 128m Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
JvmMaxNativeStackSize Size of stack in kilobytes 128k Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
JvmMinHeapSize Heap size in megabytes Im Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
ListenerConcurrency 1 through 100 1 Component This property is valid
restart only if the value of
DeliveryTransport is MQ.
Locale This is a subset of the en_US Component
supported locales: restart
en_US, ja_JP, ko KR,
zh_CN, zh_TW, fr_FR,
de DE, it_IT,
es_ES, pt_BR
LogAtInterchangeEnd true or false false Component This property is valid
restart only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
MaxEventCapacity 1 through 2147483647 2147483647 Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
MessageFileName Valid file name InterchangeSystem.txt Component
restart
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Table 12. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
MonitorQueue Any valid queue name <CONNECTORNAME> Component This property is valid
/MONITORQUEUE restart only if the value of
DuplicateEventElimination
is true and
ContainerManagedEvents
has no value.
OADAutoRestartAgent true or false false Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
OADMaxNumRetry A positive integer 1000 Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
OADRetryTimelnterval A positive integer 10 Dynamic This property is valid
in minutes only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
PollEndTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
PollFrequency A positive integer 10000 Dynamic
(in milliseconds) if broker is
ICS;
otherwise
Component
restart
PollQuantity 1 through 500 1 Agent restart | This property is valid
only if the value of
ContainerManagedEvents
is JMS.
PollStartTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
RepositoryDirectory <REMOTE> if the broker |For ICS, the value is set | Agent restart
is ICS; otherwise any to <REMOTE>
valid local directory.
RequestQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/REQUESTQUEUE restart only if the value of
DeliveryTransport
is JMS
ResponseQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/RESPONSEQUEUE restart only if the value of
DeliveryTransport is JMS.
RestartRetryCount 0 through 99 3 Dynamic
if ICS;
otherwise
Component
restart
RestartRetryInterval A value in minutes 1 Dynamic
from 1 through if ICS;
2147483647 otherwise
Component
restart
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Table 12. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update
method

Notes

RHF2MessageDomain

mrm or xml

mrm

Component
restart

This property is valid
only if the value

of DeliveryTransport

is JMS and the value of
WireFormat is CwXML.

SourceQueue

Any valid WebSphere
MQ queue name

<CONNECTORNAME>
/SOURCEQUEUE

Agent restart

This property is valid
only if the value of
ContainerManagedEvents
is JMS.

SynchronousRequest
Queue

Any valid queue name.

<CONNECTORNAME>
/SYNCHRONOUSREQUEST
QUEUE

Component
restart

This property is valid
only if the value

of DeliveryTransport
is JMS.

SynchronousRequest
Timeout

0 to any number
(milliseconds)

Component
restart

This property is valid
only if the value

of DeliveryTransport
is JMS.

SynchronousResponse
Queue

Any valid queue name

<CONNECTORNAME>
/SYNCHRONOUSRESPONSE
QUEUE

Component
restart

This property is valid
only if the value

of DeliveryTransport
is JMS.

TivoliMonitorTransaction
Performance

true or false

false

Component
restart

WireFormat

CwXML or CwBO

CwXML

Agent restart

The value of this
property must be CwXML
if the value

of RepositoryDirectory

is not set to <REMOTE>.
The value must

be CwBO if the value of
RepositoryDirectory is set
to <REMOTE>.

WsifSynchronousRequest
Timeout

0 to any number
(milliseconds)

Component
restart

This property is not valid
if the value of
BrokerType is ICS.

XMLNameSpaceFormat

short or Tong

short

Agent restart

This property is not valid
if the value of
BrokerType is

ICS.

Standard properties

This section describes the standard connector configuration properties.

AdapterHelpName

The AdapterHelpName property is the name of a directory in which
connector-specific extended help files are located. The directory must be located in
<ProductDir>\bin\Data\ App\Help and must contain at least the language
directory enu_usa. It may contain other directories according to locale.

The default value is the template name if it is valid, or it is blank.

AdmininQueue

The AdminInQueue property specifies the queue that is used by the integration
broker to send administrative messages to the connector.
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The default value is <CONNECTORNAME>/ADMININQUEUE

AdminOutQueue

The AdminOutQueue property specifies the queue that is used by the connector to
send administrative messages to the integration broker.

The default value is <CONNECTORNAME>/ADMINOUTQUEUE

AgentConnections

The AgentConnections property controls the number of ORB (Object Request
Broker) connections opened when the ORB initializes.

The default value of this property is 1.

AgentTraceLevel

The AgentTraceLevel property sets the level of trace messages for the
application-specific component. The connector delivers all trace messages
applicable at the tracing level set and lower.

The default value is 0.

ApplicationName

The ApplicationName property uniquely identifies the name of the connector
application. This name is used by the system administrator to monitor the
integration environment. This property must have a value before you can run the
connector.

The default is the name of the connector.

BrokerType

The BrokerType property identifies the integration broker type that you are using.
The value is ICS, , or .

CharacterEncoding

The CharacterEncoding property specifies the character code set used to map from
a character (such as a letter of the alphabet, a numeric representation, or a
punctuation mark) to a numeric value.

Note: Java-based connectors do not use this property. C++ connectors use the
value ascii7 for this property.

By default, only a subset of supported character encodings is displayed. To add
other supported values to the list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory (<ProductDir>). For
more information, see the Connector Configurator Express appendix in this guide.

ConcurrentEventTriggeredFlows

The ConcurrentEventTriggeredFlows property determines how many business
objects can be concurrently processed by the connector for event delivery. You set
the value of this attribute to the number of business objects that are mapped and
delivered concurrently. For example, if you set the value of this property to 5, five
business objects are processed concurrently.
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Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), the following properties must configured:

* The collaboration must be configured to use multiple threads by setting its
Maximum number of concurrent events property high enough to use multiple
threads.

* The destination application’s application-specific component must be configured
to process requests concurrently.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and is performed serially.

This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1.

ContainerManagedEvents

The ContainerManagedEvents property allows a JMS-enabled connector with a
JMS event store to provide guaranteed event delivery, in which an event is
removed from the source queue and placed on the destination queue as one JMS
transaction.

When this property is set to JMS, the following properties must also be set to
enable guaranteed event delivery:

¢ PollQuantity = 1 to 500
* SourceQueue = /SOURCEQUEUE

You must also configure a data handler with the MimeType and DHClass (data
handler class) properties. You can also add DataHandlerConfigMOName (the
meta-object name, which is optional). To set those values, use the Data Handler
tab in Connector Configurator Express.

Although these properties are adapter-specific, here are some example values:
* MimeType = text\xml

* DHClass = com.crossworlds.DataHandlers.text.xml

* DataHandlerConfigMOName = MO_DataHandler_Default

The fields for these values in the Data Handler tab are displayed only if you have
set the ContainerManagedEvents property to the value JMS.

Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pollForEvents() method, thereby disabling that method’s functionality.

The ContainerManagedEvents property is valid only if the value of the
DeliveryTransport property is set to JMS.

There is no default value.
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ControllerEventSequencing

The ControllerEventSequencing property enables event sequencing in the connector
controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE> (BrokerType is ICS).

The default value is true.

ControllerStoreAndForwardMode

The ControllerStoreAndForwardMode property sets the behavior of the connector
controller after it detects that the destination application-specific component is
unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches InterChange Server Express (ICS), the connector
controller blocks the request to the application-specific component. When the
application-specific component becomes operational, the controller forwards the
request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific

component is unavailable.

This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE> (the value of the BrokerType property is ICS).

The default value is true.

ControllerTraceLevel

The ControllerTraceLevel property sets the level of trace messages for the
connector controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE>.

The default value is 0.

DeliveryQueue

The DeliveryQueue property defines the queue that is used by the connector to
send business objects to the integration broker.

This property is valid only if the value of the DeliveryTransport property is set to
JMS.

The default value is <CONNECTORNAME>/DELIVERYQUEUE.
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DeliveryTransport

The DeliveryTransport property specifies the transport mechanism for the delivery
of events. For Java Messaging Service, the value is JMS.

* If the value of the RepositoryDirectory property is set to <REMOTE>, the value
of the DeliveryTransport property can be IDL or JMS, and the default is IDL.

* If the value of the RepositoryDirectory property is a local directory, the value
can be only JMS.

The connector sends service-call requests and administrative messages over
CORBA 1IIOP if the value of the RepositoryDirectory property is IDL.

The default value is JMS.
JMS

The JMS transport mechanism enables communication between the connector and
client connector framework using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as

jms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName
are listed in Connector Configurator Express. The properties

Jjms .MessageBrokerName and jms.FactoryClassName are required for this transport.

There may be a memory limitation if you use the JMS transport mechanism for a
connector in the following environment when InterChange Server Espress (ICS) is
the integration broker.

In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client. If your installation uses less than 768MB of
process heap size, set the following variable and property:

* Set the LDR_CNTRL environment variable in the CWSharedEnv.sh script.
This script is located in the \bin directory below the product directory

(<ProductDir>). Using a text editor, add the following line as the first line in the
CWSharedEnv.sh script:

export LDR_CNTRL=MAXDATA=0x30000000

This line restricts heap memory usage to a maximum of 768 MB (3 segments *
256 MB). If the process memory grows larger than this limit, page swapping can
occur, which can adversely affect the performance of your system.

* Set the value of the IPCCBaseAddress property to 11 or 12. For more
information on this property, see the WebSphere Business Integration Server Express
Installation Guide for Windows..

DuplicateEventElimination

When the value of this property is true, a JMS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, during
connector development, the connector must have a unique event identifier set as
the business object ObjectEventld attribute in the application-specific code.

Note: When the value of this property is true, the MonitorQueue property must
be enabled to provide guaranteed event delivery.

The default value is false.
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EnableOidForFlowMonitoring

When the value of this property is true, the adapter runtime will mark the
incoming ObjectEventID as a foreign key for flow monitoring.

This property is only valid if the BrokerType property is set to ICS.

The default value is false.

FaultQueue

If the connector experiences an error while processing a message, it moves the
message (and a status indicator and description of the problem) to the queue
specified in the FaultQueue property.

The default value is <CONNECTORNAME>/FAULTQUEUE.

jms.FactoryClassName

The jms.FactoryClassName property specifies the class name to instantiate for a
JMS provider. This property must be set if the value of the DeliveryTransport
property is JMS.

The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.

jms.ListenerConcurrency

The jms.ListenerConcurrency property specifies the number of concurrent listeners
for the JMS controller. It specifies the number of threads that fetch and process
messages concurrently within a controller.

This property is valid only if the value of the jms.OptimizedTransport property is
true.

The default value is 1.

jms.MessageBrokerName

The jms.MessageBrokerName specifies the broker name to use for the JMS
provider. You must set this connector property if you specify JMS as the delivery
transport mechanism (in the DeliveryTransport property).

When you connect to a remote message broker, this property requires the following
values:

QueueMgrName : Channel :Hos tName : PortNumber

where:

QueueMgriName is the name of the queue manager.

Channel is the channel used by the client.

HostName is the name of the machine where the queue manager is to reside.
PortNumberis the port number used by the queue manager for listening

For example:
jms .MessageBrokerName = WBIMB.Queue.Manager:CHANNEL1:RemoteMachine:1456

The default value is crossworlds.queue.manager. Use the default when connecting
to a local message broker.
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jms.NumConcurrentRequests

The jms.NumConcurrentRequests property specifies the maximum number of
concurrent service call requests that can be sent to a connector at the same time.
Once that maximum is reached, new service calls are blocked and must wait for
another request to complete before proceeding.

The default value is 10.

jms.Password

The jms.Password property specifies the password for the JMS provider. A value
for this property is optional.

There is no default value.

jms.TransportOptimized

The jms.TransportOptimized property determines if the WIP (work in progress) is
optimized. You must have a WebSphere MQ provider to optimize the WIP. For
optimized WIP to operate, the messaging provider must be able to:

1. Read a message without taking it off the queue

2. Delete a message with a specific ID without transferring the entire message to
the receiver’s memory space

3. Read a message by using a specific ID (needed for recovery purposes)

4. Track the point at which events that have not been read appear.

The JMS APIs cannot be used for optimized WIP because they do not meet
conditions 2 and 4 above, but the MQ Java APIs meet all four conditions, and

hence are required for optimized WIP.

This property is valid only if the value of DeliveryTransport is JMS and the value of
BrokerType is ICS.

The default value is false.

jms.UserName

the jms.UserName property specifies the user name for the J]MS provider. A value
for this property is optional.

There is no default value.

JvmMaxHeapSize

The JvmMaxHeapSize property specifies the maximum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128m.

JvmMaxNativeStackSize

The JvmMaxNativeStackSize property specifies the maximum native stack size for
the agent (in kilobytes).
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This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128k.

JvmMinHeapSize

The JvmMinHeapSize property specifies the minimum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1m.

ListenerConcurrency

The ListenerConcurrency property supports multithreading in WebSphere MQ
Listener when ICS is the integration broker. It enables batch writing of multiple
events to the database, thereby improving system performance.

This property valid only with connectors that use MQ transport. The value of the
DeliveryTransport property must be MQ.

The default value is 1.

Locale

The Locale property specifies the language code, country or territory, and,
optionally, the associated character code set. The value of this property determines
cultural conventions such as collation and sort order of data, date and time
formats, and the symbols used in monetary specifications.

A locale name has the following format:
Ul _TT.codeset

where:

Il is a two-character language code (in lowercase letters)

TT is a two-letter country or territory code (in uppercase letters)

codeset is the name of the associated character code set (may be optional).

By default, only a subset of supported locales are listed. To add other supported
values to the list, you modify the \Data\Std\stdConnProps.xml file in the
<ProductDir>\bin directory. For more information, refer to the Connector
Configurator Express appendix in this guide.

If the connector has not been internationalized, the only valid value for this
property is en_US. To determine whether a specific connector has been globalized,

refer to the user guide for that adapter.

The default value is en_US.

LogAtinterchangeEnd

The LogAtInterchangeEnd property specifies whether to log errors to the log
destination of the integration broker.
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Logging to the log destination also turns on e-mail notification, which generates
e-mail messages for the recipient specified as the value of MESSAGE_RECIPIENT
in the InterchangeSystem.cfg file when errors or fatal errors occur. For example,
when a connector loses its connection to the application, if the value of
LogAtInterChangeEnd is true, an e-mail message is sent to the specified message
recipient.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is false.

MaxEventCapacity

The MaxEventCapacity property specifies maximum number of events in the
controller buffer. This property is used by the flow control feature.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The value can be a positive integer between 1 and 2147483647.

The default value is 2147483647.

MessageFileName

The MessageFileName property specifies the name of the connector message file.
The standard location for the message file is \connectors\messages in the product
directory. Specify the message file name in an absolute path if the message file is
not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product
directory.

Note: To determine whether a connector has its own message file, see the
individual adapter user guide.

The default value is InterchangeSystem.txt.

MonitorQueue

The MonitorQueue property specifies the logical queue that the connector uses to
monitor duplicate events.

It is valid only if the value of the DeliveryTransport property is JMS and the value
of the DuplicateEventElimination is true.

The default value is <CONNECTORNAME>/MONITORQUEUE

OADAutoRestartAgent

the OADAutoRestartAgent property specifies whether the connector uses the
automatic and remote restart feature. This feature uses the WebSphere
MQ-triggered Object Activation Daemon (OAD) to restart the connector after an
abnormal shutdown, or to start a remote connector from System Monitor.
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This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the WebSphere MQ-triggered OAD
feature. see the WebSphere Business Integration Server Express Installation Guide for
Windows.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is false.

OADMaxNumRetry

The OADMaxNumRetry property specifies the maximum number of times that the
WebSphere MQ-triggered Object Activation Daemon (OAD) automatically attempts
to restart the connector after an abnormal shutdown. The OADAutoRestartAgent
property must be set to true for this property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is 1000.

OADRetryTimelnterval

The OADRetryTimelnterval property specifies the number of minutes in the
retry-time interval for the WebSphere MQ-triggered Object Activation Daemon
(OAD). If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this
property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is 10.

PollEndTime

The PollEndTime property specifies the time to stop polling the event queue. The
format is HH: MM, where HH is 0 through 23 hours, and MM represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
e PollEndTime set and PollStartTime not set

it will poll using the value configured for the PollFrequency property.

PollFrequency

The PollFrequency property specifies the amount of time (in milliseconds) between
the end of one polling action and the start of the next polling action. This is not
the interval between polling actions. Rather, the logic is as follows:
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* Poll to obtain the number of objects specified by the value of the PollQuantity
property.

* Process these objects. For some connectors, this may be partly done on separate
threads, which execute asynchronously to the next polling action.

* Delay for the interval specified by the PollFrequency property.
* Repeat the cycle.

The following values are valid for this property:
¢ The number of milliseconds between polling actions (a positive integer).

* The word no, which causes the connector not to poll. Enter the word in
lowercase.

* The word key, which causes the connector to poll only when you type the letter
p in the connector Command Prompt window. Enter the word in lowercase.

The default is 10000.

Important: Some connectors have restrictions on the use of this property. Where
they exist, these restrictions are documented in the chapter on
installing and configuring the adapter.

PollQuantity

The PollQuantity property designates the number of items from the application
that the connector polls for. If the adapter has a connector-specific property for
setting the poll quantity, the value set in the connector-specific property overrides
the standard property value.

This property is valid only if the value of the DeliveryTransport property is JMS,
and the ContainerManagedEvents property has a value.

An e-mail message is also considered an event. The connector actions are as
follows when it is polled for e-mail.

* When it is polled once, the connector detects the body of the message, which it
reads as an attachment. Since no data handler was specified for this mime type,
it will then ignore the message.

* The connector processes the first BO attachment. The data handler is available
for this MIME type, so it sends the business object to Visual Test Connector.

* When it is polled for the second time, the connector processes the second BO
attachment. The data handler is available for this MIME type, so it sends the
business object to Visual Test Connector.

* Once it is accepted, the third BO attachment should be transmitted.

PollStartTime

The PollStartTime property specifies the time to start polling the event queue. The
format is HH: MM, where HH is O through 23 hours, and MY represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
e PollEndTime set and PollStartTime not set
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it will poll using the value configured for the PollFrequency property.

RepositoryDirectory

The RepositoryDirectory property is the location of the repository from which the
connector reads the XML schema documents that store the metadata for business
object definitions.

If the integration broker is ICS, this value must be set to set to <REMOTE>
because the connector obtains this information from the InterChange Server
Express repository.

When the integration broker is a WebSphere message broker or WAS, this value is
set to <ProductDir>\repository by default. However, it may be set to any valid
directory name.

RequestQueue

The RequestQueue property specifies the queue that is used by the integration
broker to send business objects to the connector.

This property is valid only if the value of the DeliveryTransport property is JMS.

The default value is <CONNECTORNAME>/REQUESTQUEUE.

ResponseQueue

The ResponseQueue property specifies the JMS response queue, which delivers a
response message from the connector framework to the integration broker. When
the integration broker is InterChange Server Express (ICS), the server sends the
request and waits for a response message in the JMS response queue.

This property is valid only if the value of the DeliveryTransport property is JMS.

The default value is <CONNECTORNAME>/RESPONSEQUEUE.

RestartRetryCount

The RestartRetryCount property specifies the number of times the connector
attempts to restart itself. When this property is used for a connector that is
connected in parallel, it specifies the number of times the master connector
application-specific component attempts to restart the client connector
application-specific component.

The default value is 3.

RestartRetryinterval

The RestartRetryInterval property specifies the interval in minutes at which the
connector attempts to restart itself. When this property is used for a connector that
is linked in parallel, it specifies the interval at which the master connector
application-specific component attempts to restart the client connector
application-specific component.

Possible values for the property range from 1 through 2147483647 .

The default value is 1.
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RHF2MessageDomain

The RHF2MessageDomain property allows you to configure the value of the field
domain name in the JMS header. When data is sent to a WebSphere message
broker over JMS transport, the adapter framework writes JMS header information,
with a domain name and a fixed value of mrm. A configurable domain name lets
you track how the WebSphere message broker processes the message data.

This is an example header:

<mcd><Msd>mrm</Msd><Set>3</Set><Type>
Retek_POPhyDesc</Type><Fmt>CwXML</Fmt></mcd>

This property is not valid if the value of BrokerType is ICS. Also, it is valid only if
the value of the DeliveryTransport property is JMS, and the value of the
WireFormat property is CwXML.

Possible values are mrm and xml. The default value is mrm.

SourceQueue

The SourceQueue property designates the JMS source queue for the connector
framework in support of guaranteed event delivery for [MS-enabled connectors

that use a JMS event store. For further information, see|“ContainerManagedEvents”]
i

This property is valid only if the value of DeliveryTransport is JMS, and a value for
ContainerManagedEvents is specified.

The default value is <CONNECTORNAME>/SOURCEQUEUE.

SynchronousRequestQueue

The SynchronousRequestQueue property delivers request messages that require a
synchronous response from the connector framework to the broker. This queue is
necessary only if the connector uses synchronous execution. With synchronous
execution, the connector framework sends a message to the synchronous request
queue and waits for a response from the broker on the synchronous response
queue. The response message sent to the connector has a correlation ID that
matches the ID of the original message.

This property is valid only if the value of DeliveryTransport is JMS.

The default value is <CONNECTORNAME>/SYNCHRONOUSREQUESTQUEUE

SynchronousRequestTimeout
The SynchronousRequestTimeout property specifies the time in milliseconds that
the connector waits for a response to a synchronous request. If the response is not
received within the specified time, the connector moves the original synchronous
request message (and error message) to the fault queue.

This property is valid only if the value of DeliveryTransport is JMS.

The default value is 0.
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SynchronousResponseQueue

The SynchronousResponseQueue property delivers response messages in reply to a
synchronous request from the broker to the connector framework. This queue is
necessary only if the connector uses synchronous execution.

This property is valid only if the value of DeliveryTransport is JMS.

The default is <CONNECTORNAME>/SYNCHRONOUSRESPONSEQUEUE

TivoliMonitorTransactionPerformance

The TivoliMonitorTransactionPerformance property specifies whether IBM Tivoli
Monitoring for Transaction Performance (ITMTP) is invoked at run time.

The default value is false.

WireFormat
The WireFormat property specifies the message format on the transport:

* If the value of the RepositoryDirectory property is a local directory, the value is
CwXML.

¢ If the value of the RepositoryDirectory property is a remote directory, the value
is CwBO.
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Appendix B. Connector Configurator Express

This appendix describes how to use Connector Configurator Express to set
configuration property values for your adapter.

You use Connector Configurator Express to:

* Create a connector-specific property template for configuring your connector
* Create a configuration file

* Set properties in a configuration file

The topics covered in this appendix are:

* [“Overview of Connector Configurator Express’]

+ |“Creating a connector-specific property template” on page 75

+ [“Creating a new configuration file” on page 77|

+ |“Setting the configuration file properties” on page 80|

Overview of Connector Configurator Express

Connector Configurator Express allows you to configure the connector component
of your adapter for use with the InterChange Server Express integration broker.

You use Connector Configurator Express to:
* Create a connector-specific property template for configuring your connector.

* Create a connector configuration file; you must create one configuration file for
each connector you install.

* Set properties in a configuration file.
You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and, with InterChange Server Express, maps for use with
collaborations as well as specify messaging, logging and tracing, and data
handler parameters, as required.

Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).

Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator Express incorporates them
into your configuration file as soon as you create the file. However, you do need to
set the value of each standard property in Connector Configurator Express.

The range of standard properties may not be the same for all brokers and all
configurations. Some properties are available only if other properties are given a
specific value. The Standard Properties window in Connector Configurator Express
will show the properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties

and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
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your system, in which case, you simply use that. If not, follow the steps in
[“Creating a new template” on page 75[to set up a new one.

Starting Connector Configurator Express

You can start and run Connector Configurator Express in either of two modes:
* Independently, in stand-alone mode
* From System Manager

Running Configurator in stand-alone mode

You can run Connector Configurator Express without running System Manager
and work with connector configuration files, irrespective of your broker.

To do so:

 Start>All Programs, click IBM WebSphere Business Integration
Express>Toolset Express>Development>Connector Configurator Express.

* Select File>New>Connector Configuration.

* When you click the pull-down menu next to System Connectivity Integration
Broker, you can select ICS.

You may choose to run Connector Configurator Express independently to generate
the file, and then connect to System Manager to save it in a System Manager
project (see|’Completing a configuration file” on page 79)

Running Configurator from System Manager

You can run Connector Configurator Express from System Manager.

To run Connector Configurator Express:

1. Open the System Manager.

2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator
Express. The Connector Configurator Express window opens and displays a
New Connector dialog box.

4. When you click the pull-down menu next to System Connectivity Integration
Broker, you can select ICS.

To edit an existing configuration file:

* In the System Manager window, select any of the configuration files listed in the
Connector folder and right-click on it. Connector Configurator Express opens
and displays the configuration file with the integration broker type and file
name at the top.

* From Connector Configurator Express, select File>Open. Select the name of the
connector configuration file from a project or from the directory in which it is
stored.

* Click the Standard Properties tab to see which properties are included in this
configuration file.
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Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing connector definition as the template.

+ To create a new template, see [‘Creating a new template” on page 75|

¢ To use an existing file, simply modify an existing template and save it under the
new name. You can find existing templates in your \ProductDir\bin\Data\App
directory.

Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template in Connector Configurator Express:
1. Click File>New>Connector-Specific Property Template.
2. The Connector-Specific Property Template dialog box appears.

* Enter a name for the new template in the Name field below Input a New
Template Name. You will see this name again when you open the dialog box
for creating a new configuration file from a template.

* To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template appears in the Template Preview
display.

3. You can use an existing template whose property definitions are similar to
those required by your connector as a starting point for your template. If you
do not see any template that displays the connector-specific properties used by
your connector, you will need to create one.

* If you are planning to modify an existing template, select the name of the
template from the list in the Template Name table below Select the Existing
Template to Modify: Find Template.

* This table displays the names of all currently available templates. You can
also search for a template.

Specifying general characteristics
When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:
* General:

Property Type

Property Subtype

Updated Method

Description
* Flags

Standard flags
e Custom Flag

Flag
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The Property Subtype can be selected when Property Type is a String. It is an
optional value which provides syntax checking when you save the configuration
file. The default is a blank space, and means that the property has not been
subtyped.

After you have made selections for the general characteristics of the property, click
the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1. Click the Value tab. The display panel for Value replaces the display panel for
General.

2. Select the name of the property in the Edit properties display.
3. In the fields for Max Length and Max Multiple Values, enter your values.

To create a new property value:
1. Right-click on the square to the left of the Value column heading.

2. From the pop-up menu, select Add to display the Property Value dialog box.
Depending on the property type, the dialog box allows you to enter either a
value, or both a value and a range.

3. Enter the new property value and click OK. The value appears in the Value
panel on the right.

The Value panel displays a table with three columns:

The Value column shows the value that you entered in the Property Value dialog
box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value dialog
box.

After a value has been created and appears in the grid, it can be edited from
within the table display.

To make a change in an existing value in the table, select an entire row by clicking
on the row number. Then right-click in the Value field and click Edit Value.

Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Po11Quantity appears in the template only if JMS is the
transport mechanism and DuplicateEventETimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1. In the Available Properties display, select the property that will be made
dependent.
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2. In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

3. In the Condition Operator field, select one of the following:
== (equal to)
!= (not equal to)
> (greater than)
< (less than)
>= (greater than or equal to)
<=(less than or equal to)

4. In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

5. With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

6. Click Finish. Connector Configurator Express stores the information you have
entered as an XML document, under \data\app in the \bin directory where you
have installed Connector Configurator Express.

Setting pathnames
Some general rules for setting pathnames are:

¢ The maximum length of a filename in Windows is 255 characters.

¢ In Windows, the absolute pathname must follow the format
[Drive:][Directory]\filename: for example,
C:\WebSphereAdapters\bin\Data\Std \StdConnProps.xml

* Queue names may not have leading or embedded spaces.

Creating a new configuration file

When you create a new configuration file, you must name it and select an
integration broker.

You also select an operating system for extended validation on the file. The toolbar
has a droplist called Target System that allows you to select the target operating
system for extended validation of the properties. The available options for
Windows is no extended validation (switches off extended validation). The default
on startup is Windows.

To start Connector Configurator Express:

* In the System Manager window, select Connector Configurator Express from
the Tools menu. Connector Configurator Express opens.

¢ In stand-alone mode, launch Connector Configurator Express.

To set the operating system for extended validation of the configuration file:
¢ Pull down the Target System: droplist on the menu bar.
* Select the operating system you are running on.

Then select File>New>Connector Configuration. In the New Connector window,
enter the name of the new connector.

You also need to select an integration broker. The broker you select determines the
properties that will appear in the configuration file. To select a broker:

* In the Integration Broker field, select ICS.

Appendix B. Connector Configurator Express 77



* Complete the remaining fields in the New Connector window, as described later
in this chapter.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:

1. Set the operating system for extended validation of the configuration file using
the Target System: droplist on the menu bar (see “Creating a new configuration
file” above).

2. Click File>New>Connector Configuration.
3. The New Connector dialog box appears, with the following fields:
* Name

Enter the name of the connector. Names are case-sensitive. The name you
enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Important: Connector Configurator Express does not check the spelling of
the name that you enter. You must ensure that the name is
correct.

* System Connectivity
Click ICS.
* Select Connector-Specific Property Template

Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

4. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector name. You can fill in all
the field values to complete the definition now, or you can save the file and
complete the fields later.

5. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running. If you save as a file, the Save File
Connector dialog box appears. Choose *.cfg as the file type, verify in the File
Name field that the name is spelled correctly and has the correct case, navigate
to the directory where you want to locate the file, and click Save. The status
display in the message panel of Connector Configurator Express indicates that
the configuration file was successfully created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

6. To complete the connector definition, enter values in the fields for each of the

tabs of the Connector Configurator Express window, as described later in this
chapter.

Using an existing file

You may have an existing file available in one or more of the following formats:
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* A connector definition file.This is a text file that lists properties and applicable
default values for a specific connector. Some connectors include such a file in a
\repository directory in their delivery package (the file typically has the
extension .txt; for example, CN_]JMS.txt for the JMS connector).

* An ICS repository file. Definitions used in a previous ICS implementation of the
connector may be available to you in a repository file that was used in the
configuration of that connector. Such a file typically has the extension .1in or
.out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.

Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete
until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *.cfg, or *.in file from a directory:
1. In Connector Configurator Express, click File>Open>From File.

2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

¢ Configuration (x.cfg)
* ICS Repository (*.1in, =.out)

Choose this option if a repository file was used to configure the connector in
an ICS environment. A repository file may include multiple connector
definitions, all of which will appear when you open the file.

« All files (*.%)
Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,
select it, and click Open.

Follow these steps to open a connector configuration from a System Manager

project:

1. Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator Express.

3. Click File>Open>From Project.

Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator Express window displays the configuration screen, with the current
attributes and values.

The title of the configuration screen displays the integration broker and connector
name as specified in the file. Make sure you have the correct broker. If not, change
the broker value before you configure the connector. To do so:

1. Under the Standard Properties tab, select the value field for the BrokerType
property. In the drop-down menu, select the value ICS.
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2. The Standard Properties tab will display the connector properties associated
with the selected broker. The table shows Property name, Value, Type, Subtype
(if the Type is a string), Description, and Update Method.

3. You can save the file now or complete the remaining configuration fields, as
described in [‘Specifying supported business object definitions” on page 83.

4. When you have finished your configuration, click File>Save>To Project or
File>Save>To File.

If you are saving to file, select *.cfg as the extension, select the correct location
for the file and click Save.

If multiple connector configurations are open, click Save All to File to save all
of the configurations to file, or click Save All to Project to save all connector
configurations to a System Manager project.

Before you created the configuration file, you used the Target System droplist
that allows you to select the target operating system for extended validation of
the properties.

Before it saves the file, Connector Configurator Express checks that values have
been set for all required standard properties. If a required standard property is
missing a value, Connector Configurator Express displays a message that the
validation failed. You must supply a value for the property in order to save the
configuration file.

If you have elected to use the extended validation feature by selecting a value
of Windows from the Target System droplist, the system will validate the
property subtype s well as the type, and it displays a warning message if the
validation fails.

Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator Express displays a
configuration screen with tabs for the categories of required configuration values.

Connector Configurator Express requires values for properties in these categories
for connectors running on all brokers:

 Standard Properties

* Connector-specific Properties
* Supported Business Objects
* Trace/Log File values

» Data Handler (applicable for connectors that use JMS messaging with
guaranteed event delivery)

Note: For connectors that use JMS messaging, an additional category may display,
for configuration of data handlers that convert the data to business objects.

For connectors running on InterChange Server Express, values for these properties
are also required:

* Associated Maps
* Security

Important: Connector Configurator Express accepts property values in either
English or non-English character sets. However, the names of both
standard and connector-specific properties, and the names of supported
business objects, must use the English character set only.
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Standard properties differ from connector-specific properties as follows:

 Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in Appendix A of
each adapter guide. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are
color-coded to show which are configurable:

A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.

A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.

* Value fields are configurable.

* The Update Method field is displayed for each property. It indicates whether a
component or agent restart is necessary to activate changed values. You cannot
configure this setting.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.
2. Either enter a value, or select one from the drop-down menu if it appears.

Note: If the property has a Type of String, it may have a subtype value in the
Subtype column. This subtype is used for extended validation of the
property.

3. After entering all the values for the standard properties, you can do one of the
following:

* To discard the changes, preserve the original values, and exit Connector
Configurator Express, click File>Exit (or close the window), and click No
when prompted to save changes.

* To enter values for other categories in Connector Configurator Express, select
the tab for the category. The values you enter for Standard Properties (or
any other category) are retained when you move to the next category. When
you close the window, you are prompted to either save or discard the values
that you entered in all the categories as a whole.

» To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

To get more information on a particular standard property, left-click the entry in
the Description column for that property in the Standard Properties tabbed sheet.
If you have Extended Help installed, an arrow button will appear on the right.
When you click on the button, a Help window will open and display details of the
standard property.
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Note: If the hot button does not appear, no Extended Help was found for that
property.

If installed, the Extended Help files are located in
<ProductDir>\bin\Data\Std \Help\ <RegionalSetting>\.

Setting connector-specific configuration properties

For connector-specific configuration properties, you can add or change property

names, configure values, delete a property, and encrypt a property. The default

property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.

Note: If the property has a Type of String, you can select a subtype from the
Subtype droplist. This subtype is used for extended validation of the
property.

3. To encrypt a property, select the Encrypt box.

4. To get more information on a particular property, left-click the entry in the
Description column for that property. If you have Extended Help installed, a
hot button will appear. When you click on the hot button, a Help window will
open and display details of the standard property.

Note: If the hot button does not appear, no Extended Help was found for that
property.
5. Choose to save or discard changes, as described for [“Setting standard connector]
[properties” on page 81.|

If the Extended Help files are installed and the AdapterHelpName property is
blank, Connector Configurator Express will point to the adapter-specific Extended
Help files located in <ProductDir>\bin\Data\ App\Help\ <RegionalSetting>\.
Otherwise, Connector Configurator Express will point to the adapter-specific
Extended Help files located in
<ProductDir>\bin\Data\ App\Help\ <AdapterHelpName>\ <RegionalSetting>\. See
the AdapterHelpName property described in the Standard Properties appendix.

The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Connector-specific Properties window. To decrypt a value, click to clear
the Encrypt check box, enter the correct value in the Verification dialog box, and
click OK. If the entered value is correct, the value is decrypted and displays.

The adapter user guide for each connector contains a list and description of each
property and its default value.
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If a property has multiple values, the Encrypt check box will appear for the first
value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method
Refer to the descriptions of update methods found in the Standard Properties

appendix, under "Standard connector properties overview’lAppendix A, ”Standardl
lconfiguration properties for connectors,” on page 53/

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator Express to
specify the business objects that the connector will use. You must specify both
generic business objects and application-specific business objects, and you must
specify associations for the maps between the business objects.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
(using meta-objects) with their applications.

InterChange Server Express as your broker

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name: To designate that a business object definition is supported
by the connector, with System Manager running:

1. Click an empty field in the Business Object Name list. A drop list displays,
showing all the business object definitions that exist in the System Manager
project.

2. Click on a business object to add it.

3. Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator Express window, click Save to
Project. The revised connector definition, including designated support for the
added business object definition, is saved to an ICL (Integration Component
Library) project in System Manager.

To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator Express window, click
Delete Row. The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support: If a business object has Agent Support, the system will attempt to

use that business object for delivering data to an application via the connector
agent.
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Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.

To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator Express window does not
validate your Agent Support selections.

Maximum transaction level: The maximum transaction level for a connector is
the highest transaction level that the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

Associated maps

Each connector supports a list of business object definitions and their associated
maps that are currently active in InterChange Server Express. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:
* Business Object Name

These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator Express window.

* Associated Maps
The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit Binding
In some cases, you may need to explicitly bind an associated map.
Explicit binding is required only when more than one map exists for a particular
supported business object. When InterChange Server Express boots, it tries to
automatically bind a map to each supported business object for each connector.

If more than one map takes as its input the same business object, the server
attempts to locate and bind one map that is the superset of the others.
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If there is no map that is the superset of the others, the server will not be able to

bind the business object to a single map, and you will need to set the binding

explicitly.

To explicitly bind a map:

1. In the Explicit column, place a check in the check box for the map you want
to bind.

2. Select the map that you intend to associate with the business object.

3. In the File menu of the Connector Configurator Express window, click Save
to Project.

4. Deploy the project to InterChange Server Express.
5. Reboot the server for the changes to take effect.

Security

You can use the Security tab in Connector Configurator Express to set various
privacy levels for a message. You can only use this feature when the
DeliveryTransport property is set to JMS.

By default, Privacy is turned off. Check the Privacy box to enable it.
The Keystore Target System Absolute Pathname is:

For Windows:
<ProductDir>\connectors\security\<connectorname>.jks

This path and file should be on the system where you plan to start the connector,
that is, the target system.

You can use the Browse button at the right only if the target system is the one
currently running. It is greyed out unless Privacy is enabled and the Target System
in the menu bar is set to Windows.

The Message Privacy Level may be set as follows for the three messages categories
(All Messages, All Administrative Messages, and All Business Object Messages):

"rr,

. : is the default; used when no privacy levels for a message category have
been set.

* none: Not the same as the default: use this to deliberately set a privacy level of
none for a message category.

* integrity
* privacy

* integrity_plus_privacy

The Key Maintenance feature lets you generate, import and export public keys for
the server and adapter.

* When you select Generate Keys, the Generate Keys dialog box appears with the
defaults for the keytool that will generate the keys.

* The keystore value defaults to the value you entered in Keystore Target System
Absolute Pathname on the Security tab.

* When you select OK, the entries are validated, the key certificate is generated
and the output is sent to the Connector Configurator Express log window.
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Before you can import a certificate into the adapter keystore, you must export it
from the server keystore. When you select Export Adapter Public Key, the Export
Adapter Public Key dialog box appears.

* The export certificate defaults to the same value as the keystore, except that the
file extension is <filename>.cer.

When you select Import Server Public Key, the Import Server Public Key dialog
box appears.

* The import certificate defaults to <ProductDir>\bin\ics.cer (if the file exists on
the system).

* The import Certificate Association should be the server name. If a server is
registered, you can select it from the droplist.

The Adapter Access Control feature is enabled only when the value of
DeliveryTransport is IDL. By default, the adapter logs in with the guest identity. If
the Use guest identity box is not checked, the Adapter Identity and Adapter
Password fields are enabled.

Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator Express uses the logging and tracing values of that file as
default values. You can change those values in Connector Configurator Express.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

¢ To console (STDOUT): Writes logging or tracing messages to the STDOUT
display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

¢ To File: Writes logging or tracing messages to a file that you specify. To
specify the file, click the directory button (ellipsis), navigate to the preferred
location, provide a file name, and click Save. Logging or tracing message are
written to the file and location that you specify.

Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .10og and .txt are typical file extensions.

Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Not all adapters make use of data handlers.

See the descriptions under ContainerManagedEvents in Appendix A, Standard
Properties, for values to use for these properties.
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Saving your configuration file

When you have finished configuring your connector, save the connector
configuration file. Connector Configurator Express saves the file in the broker
mode that you selected during configuration. The title bar of Connector
Configurator Express always displays the broker mode that InterChange Server
Express is currently using.

The file is saved as an XML document. You can save the XML document in three

ways:

* From System Manager, as a file with a *.con extension in an Integration
Component Library, or

* In a directory that you specify.

* In stand-alone mode, as a file with a *.cfg extension in a directory folder. By
default, the file is saved to \WebSphereAdapters\bin\Data\App.

For details about using projects in System Manager, and for further information
about deployment, see the System Implementation Guide.

Changing a configuration file

You can change the integration broker setting for an existing configuration file.
This enables you to use the file as a template for creating a new configuration file,
which can be used with a different broker.

Note: You will need to change other configuration properties as well as the broker
mode property if you switch integration brokers.

To change your broker selection within an existing configuration file (optional):

* Open the existing configuration file in Connector Configurator Express.

* Select the Standard Properties tab.

* In the BrokerType field of the Standard Properties tab, select the value that is
appropriate for your broker. When you change the current value, the available
tabs and field selections in the properties window will immediately change, to

show only those tabs and fields that pertain to the new broker you have
selected.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator Express in a globalized environment

Connector Configurator Express is globalized and can handle character conversion
between the configuration file and the integration broker. Connector Configurator
Express uses native encoding. When it writes to the configuration file, it uses
UTE-8 encoding.
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Connector Configurator Express supports non-English characters in:
* All value fields
* Log file and trace file path (specified in the Trace/Log files tab)

The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the
drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.

For example, to add the locale en_GB to the list of values for the Locale property,
open the stdConnProps.xml file and add the line in boldface type below:

<Property name="Locale"

isRequired="true"

updateMethod="component restart">

<ValidType>String</ValidType>
<ValidValues>

<Value>ja_JP</Value>
<Value>ko_KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>

<DefaultValue>en US</DefaultValue>
</ValidValues>
</Property>
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Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. IBM may have patents or
pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents.
You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you. This
information could include technical inaccuracies or typographical errors. Changes
are periodically made to the information herein; these changes will be incorporated
in new editions of the publication. IBM may make improvements and/or changes
in the product(s) and/or the program(s) described in this publication at any time
without notice. Any references in this information to non-IBM Web sites are
provided for convenience only and do not in any manner serve as an endorsement
of those Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is at your own risk. IBM may use or
distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you. Licensees of this program who wish to
have information about it for the purpose of enabling: (i) the exchange of
information between independently created programs and other programs
(including this one) and (ii) the mutual use of the information which has been
exchanged, should contact:
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IBM Corporation

577 Airport Blvd., Suite 800
Burlingame, CA 94010
Us.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee. The licensed program described in this
document and all licensed material available for it are provided by IBM under
terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us. Any performance data
contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some
measurements may have been made on development-level systems and there is no
guarantee that these measurements will be the same on generally available
systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the
applicable data for their specific environment. Information concerning non-IBM
products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those
products and cannot confirm the accuracy of performance, compatibility or any
other claims related to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products. All statements
regarding IBM’s future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only. This information contains
examples of data and reports used in daily business operations. To illustrate them
as completely as possible, the examples include the names of individuals,
companies, brands, and products. All of these names are fictitious and any
similarity to the names and addresses used by an actual business enterprise is
entirely coincidental. COPYRIGHT LICENSE: This information contains sample
application programs in source language, which illustrate programming techniques
on various operating platforms. You may copy, modify, and distribute these sample
programs in any form without payment to IBM, for the purposes of developing,
using, marketing or distributing application programs conforming to the
application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. If you are viewing this information softcopy, the
photographs and color illustrations may not appear.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program. General-use programming interfaces
allow you to write application software that obtain the services of this program’s
tools. However, this information may also contain diagnosis, modification, and
tuning information. Diagnosis, modification and tuning information is provided to
help you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.
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Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:
i5/0S

IBM

the IBM logo

AIX

CICS

CrossWorlds

DB2

DB2 Universal Database

Domino

IMS

Informix

iSeries

Lotus

Lotus Notes

MQIntegrator

MQSeries

MVS

0S/400

Passport Advantage

SupportPac

WebSphere

z/0S

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both. MMX,
Pentium, and ProShare are trademarks or registered trademarks of Intel
Corporation in the United States, other countries, or both. Java and all Java-based
trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both. Linux is a trademark of Linus Torvalds in the United States,
other countries, or both. Other company, product or service names may be
trademarks or service marks of others.

WebSphere Business Integration Server Express and Express Plus include software

developed by the Eclipse Project
(http:/ /www.eclipse.org).

JAVA,

WebSphere Business Integration Server Express, Version 4.4, and WebSphere
Business Integration Server Express Plus, Version 4.4
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